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Preface

Purpose

This Document describes the functions, technical specifications, installation guide and system
commissioning of Dobot Magician, making it easy for users to fully understand and use it.

Intended Audience
This document is intended for:
e Customer Engineer
e Sales Engineer
* Installation and Commissioning Engineer
*  Technical Support Engineer

Change History

Date Change Description

2018/09/11 | Updated the connection figure between Dobot Magician and sliding rail

2018/06/12 | The first release

Symbol Conventions

The symbols that may be founded in this document are defined as follows.

Symbol Description
f Indicates a hazard with a high level of risk which, if not
DANGER avoided, could result in death or serious injury

f Indicates a hazard with a medium level or low level of
WARNING risk which, if not avoided, could result in minor or

moderate injury, robotic arm damage

f Indicates a potentially hazardous situation which, if not
NOTICE avoided, can result in robotic arm damage, data loss, or

unanticipated result

LANOTE Provides additional information to emphasize or

supplement important points in the main text
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1. Security Precautions

This topic describes the security precautions that should be noticed when using this product.
Please read this document carefully before using the robotic arm for the first time. This product need
to be carried out in an environment meeting design specifications, you cannot remold the product
without authorization, otherwise it could lead to product failure, and even personal injury, electric
shock, fire, etc. The installation personnel, operators, teaching personnel, and programmers of the
robotic arm must read this document carefully and use the robotic arm strictly according to the
regulations of this document strictly.

1.1 General Security

ADANGER

Robotic arm is an electrical equipment. Non-professional technicians cannot modify the
wire, otherwise it is vulnerable to injury the device or the person.

The following security rules should be followed when using the robotic arm.

*  You should comply with local laws and regulations when operating the robotic arm.
The security precautions in this document are only supplemental to local laws and
regulations.

* The DANGER, WARNING, and NOTICE marks in this document are only
supplemental to the security precautions.

*  Please use the robotic arm in the specified environment scope. If not, exceeding the
specifications and load conditions will shorten the service life of the product even damage
the equipment.

*  Before operating and maintaining the robotic arm, the personnel responsible for the
installation, operation and maintenance must be trained to understand the various security
precautions and to master the correct methods of operation and maintenance.

*  Highly corrosive cleaning is not suited to cleaning the robotic arm. The anodized
components are not suitable for immersion cleaning.

*  People cannot repair and disassemble the robotic arm without professional training.
If there is a problem with the robotic arm, please contact Dobot technical support engineer
in time.

*  Please comply with the relevant laws to deal with the product which is scrapped, and
protect the environment.

*  There are small parts in the packing box, Please keep them away from children, to
avoid any accidents.

* DO NOT Iet children play with the robotic arm alone. All processes need to be
monitored while running. After processes have finished, please turn off the equipment
promptly.

* DO NOT put hands into the workspace of the robotic arm while running, to avoid
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bruising or pinching.

»  Becareful during the robotic arm carrying or installing. Please follow the instructions
on the packing box to put down the robotic arm gently and place it correctly in direction
of arrow.

e Commissioning of the incomplete machine is prohibited until it has been installed in
a machine and the whole machine complies with the provisions of the Machinery
Directive (2006/42/EC).

e It is prohibited to modify or remove the nameplates, instructions, icons and marks
on the robotic arm and the related equipment.

*  Please refer to Dobot Magician User Guide along with the packing box before using.

1.2 Precautions

*  Please make the Dobot Magician in the workspace with a 45°angle between the
Forearm and Rear Arm (as shown in Figure 1.1) before starting up. If the LED indicator
turns red after starting up, it indicates that the Dobot Magician is at a limited position.
Please make the Dobot Magician in the workspace.

Figure 1.1 The Forearm and Rear Arm position

*  Dobot Magician will move slowly to the specific position when shutdown. DO NOT
put hands into the workspace of the Dobot while running, to avoid bruising or pinching.
Only once the LED indicator completely turns off, the Dobot Magician can be powered
down.

* If the coordinates of the Dobot Magician shown on the DobotStudio are abnormal,
please press the Reset button on the back of the base to reset Dobot Magician or click
Home on the DobotStudio page to perform homing.

*  During resetting, Dobot Magician will disconnect from the PC automatically and the
LED indicator on the base turns yellow. About 5 seconds later, if the LED indicator
turns green, it indicates that the reset is successful.

e During homing, Dobot Magician will rotate clockwise to the limited position and
then return to the homing point automatically, and the LED indicator on the base
turns blue and is blinking. After homing, if there is a beep sound and the LED
indicator turns green, it indicates that the homing is successful.
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* Please turn off the Dobot Magician completely first before connecting or
disconnecting external equipment, such as Bluetooth, WIFI, stick controller, infrared
sensor, color sensor, etc. Or, it causes damage to your device.

* Please wear the lasing protective eyeglass when using the laser module. Please
protect your eyes and skin from the laser.

*  The heating rod will produce high temperature up to 250°C when using the 3D
printing module, please be careful.

*  Please DO NOT operate or turn off Dobot Magician when burning firmware, to avoid
machine damage.
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2. Quick Start

This topic briefly describes how to operate the Dobot Magician with the software DobotStudio,
allowing you to quickly know and use the robotic arm. Figure 2.1 shows the process of getting
started with the Dobot Magician.

Start

Diagram

Install DobotStudio

Power On/Off

Get Started

End

Figure 2.1 The process of getting started with the Dobot Magician

2.1 Connecting Cables to the Dobot Magician

Step1 Connect the Dobot Magician to your computer with the supplied USB cable, as
shown in Figure 2.2,

Issue V1.7.0 (2019-01-09) User Guide Copyright © Yuejiang Technology Co., Ltd.
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Figure 2.2 Connect the Dobot Magician to your computer

Step2  Connect the Dobot Magician to the electrical outlet with the supplied power adapter,
as shown in Figure 2.3.

Figure 2.3 Connect the Dobot Magician to the electrical outlet

2.2 Installing the DobotStudio

You can control Dobot Magician by DobotStudio to implement functions such as Teaching &

Playback, fully programmable applications, and 3D printing. This topic introduces Teaching &
Playback.

221 System Requirements

The DobotStudio supports the following Windows and macOS versions.

*  Windows 7, Windows 8, and Windows 10 (This manual is explained based on this
version)
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*  macOS 10.10, macOS 10.11, and macOS 10.12
2.2.2 Obtaining the DobotStudio Package

Before using Dobot Magician, download the Windows DobotStudio package from
https://www.dobot.cc/downloadcenter.html. The macOS version is also downloadable in this URL.

223 Installing the DobotStudio

Prerequisites
The DobotStudio package has been obtained.
Procedure
Step1  Unpack the DobotStudio package to a destination directory.

For example, this directory is Installation Directory\DobotStudio. You can install
the DobotStudio to another location based on site requirements.

Step 2 In the installation directory double-click DobotStudioSetup.exe. The Select Setup
Language dialog box is displayed, as shown in Figure 2.4.

Select Setup Language X
Select the language to use during the
installation:

Chinese e
Cancel

Figure 2.4 The Select Setup Language dialog box

Step3  Choose a setup language such as English, as shown in Figure 2.5. You can also select
Chinese if needed.

Select Setup Language .

Select the language to use during the
installation:

English '

Figure 2.5 Select English

Step 4 Click OK to follow the on-screen instructions to continue with the installation.

During the installation, the Driver Installation dialog box is displayed, , two drivers
needs to be installed, as shown in Figure 2.6.
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Device Driver Installation Wizard

Welcome to the Device Driver
Installation Wizard!
This wizard helps you install the software drivers that some
computers devices need in order to work.
Device Driver Install / Unlnstall

Select INF CH341SER.INF v

[wch.cn
IoTatt |__ USB-SERIAL CH340

|__ 08/08/2014, 3.4.2014
UNINSTALL

HELP To continue, click Next

==

Figure 2.6 The Device Driver Installation Wizard dialog box

Step5  Click Next to install the first driver, and then click INSTALL to install the second
driver.
When the drivers are installed successfully, the Completing the Device Driver
Installation Wizard dialog box is displayed. Click Finish ,as shown in Figure 2.7.

Device Driver Installation Wizard

Completing the Device Driver
Installation Wizard

The drivers were successfully installed on this computer.

fou can now connect your device to this computer. i your device
came with instructions, please read them first.

Driver Name Status
w” Silicon Laboratories Inc. ... Readyto use

Bacl Cancel

Figure 2.7 The Completing the Device Driver Installation Wizard dialog box

Step 6 Click Next to continue to install the DobotStudio by following the prompts on the
Setup — DobotStudio dialog box.
When the installation is complete, the Completing the DobotStudio Setup Wizard
dialog box is displayed. Click Finish, as shown in Figure 2.8.
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) Setup - DobotStudio version 1.7.0 —

Completing the DobotStudio Setup
Wizard

Setup has finished installing DobotStudio on your computer,
The application may be launched by selecting the installed
shortouts,

Click Finish to exit Setup.

T |

Figure 2.8 The Completing the DobotStudio Setup Wizard dialog box

Step3  Click Finish.
2.24  Verifying the Installation

2.2.4.1 Verifying the DobotStudio

If the DobotStudio is launched and runs properly by double-clicking the desktop shortcut to
this program, it means that it is installed successfully.
2.2.4.2 Verifying the Dobot Magician Driver

If an available COM port is displayed on the upper left corner of the DobotStudio page after
the robotic arm is powered on, as shown in Figure 2.9, the Dobot Magician driver is installed
successfully.

Setting

Teaching & Playback Write & Draw Blockly

Figure 2.9 An available COM port is displayed

If no COM port is available, check whether the robotic arm driver is successfully installed by
following the steps below.

Step1  Connect the Dobot Magician to your computer with the supplied USB cable.
Step 2 Press the power button to apply power.
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Step3  Launch the Device Manager window to locate the Ports (COM & LPT) section. If
the item Silicon Labs CP210x USB to UART Bridge (COM6) or USB-SERIAL
CH340(COM3) is displayed, it means the Dobot Magician driver is installed

successfully.

& Device Manager
File Action View Help
e @ E=E B
~ & Evan-PC A

i Audio inputs and outputs

e Bluetooth

[ Computer

= Disk drives

[ Display adapters

) Human Interface Devices

=g |DE ATA/ATAP| controllers

_T: Imaging devices

= Keyboards
@ Mice and other pointing devices
[ Monitors
@ Network adapters
@ Ports (COM & LPT)
E Silicon Labs CP210x USE to UART Bridge (COME)

I~ Print queues w

<

Figure 2.10 The V2 robotic arm driver in Device Manager window

& Computer Management
File Action View Help
e aEHEE 2

&/ Computer Management (Local [ v & Evan-PC

v |} System Tools i Audie inputs and outputs
(®) Task Scheduler @ Bluetooth
[E Event Viewer [ Computer
i Shared Folders s Disk drives
(&) Performance [ Display adapters
& Device Manager F# Human Interface Devices
v 2 storage =z IDE ATA/ATAP! controllers
(& Disk Management T Imaging devices
=y Services and Applications = Keyboards

B Mice and other pointing devices
[ Menitors

I Network adapters

@ Portable Devices

fl_Pors (COM & LPT)

7= Prnt queues

[ Processors

3 Sensors

i SM Driver

B Software devices

i Sound, video and game controllers

S Storage controllers

i System devices

§ Universal Serial Bus controllers
§ Universal Serial Bus devices

Figure 2.11 The V1 robotic arm driver in Device Manager window

LAONOTE

* To reinstall the Dobot Magician driver after uninstalling it, install the driver
corresponding to the Windows version in the directory Installation
Directory\DobotStudio\attachment\Drive\HardwareV1.0.0. For example, install
the 64-bit driver on a 64-bit Windows 10, as shown in Figure 2.12.
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Win10 - u] b
Home Share View [7]

« v 4 <« Program Files )I DobotStudio » attachment » Drive » HardwareV1.0.0 » Winl10 » v EJI Search Win10 @

~
Name Date modified Type Size
7 Quick access

arm A File folder

e Creative Cloud Files x64 A Filefolder

*86 A File folder

22 Dropbox

|=] CP210x_Universal_Windows _Driver Relea... 5/ Text Document 15 KB
@ OneDrive |5& cra10xCPInstaller_x6d.exe 5/4/2018 Application 1,026 KB
5 [ This C E CP210xVCPinstaller_x36.exe 5/4/2018 444 PM Application 903 KB
|2] dpinstaxml 5/4/2018 444 PM AML File 12KB
¥ Network =4 silabser.cat 5/4/2018 4:44 PM Security Catalog 12 KB
2] silabser.inf f4/2018 4:44 PM Setup Informaticn 11KB
|Z] SLAB License_Agreement VCP_Windows... 5/4/2012 4:44 PM Text Decument 9Ke
10 tems E

Figure 2.12 Install the 64-bit driver on a 64-bit Windows 10

* |f the DobotStudio hardware version is 0.0.0, install the driver matching the
Windows version in the directory:

Installation Directory\DobotStudio\attachment\Drive\HardwareV0.0.0.

Please connect the DobotStudio to the robotic arm and then click to

check the hardware version.
2.3 Powering On/Off the Dobot Magician

e  Power on: align the Dobot Magician into its neutral position with its Forearm and
Rear Arm constructing a 45-degree angle, and press down the power button in the
base, as shown in Figure 2.13. Once the robotic arm is powered on, the LED indicator
turns yellow, and all the stepper motors lock. And then wait about seven seconds, a
short beep sound will be heard, and the LED indicator turns from yellow to green.
Now the Dobot Magician is ready to use.

ANOTICE

If the LED indicator is red after powering on the Dobot Magician, it means that the
robotic arm reaches its limited position. To go back to the workspace, press and hold the

unlock button ‘) on the Forearm to move the robotic arm to another desired position

After releasing the button the LED indicator turns green.
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Figure 2.13 The gesture of Dobot Magician before power-on

e Power off: When the LED indicator is green, press down the power button to turn
off the robotic arm. In this case, the Forearm moves slowly to the Rear Arm while
the angle between them becomes small. Finally, the two arms reach a specific
position.

AWARNING

During the shutdown process, watch your hand.

2.4 Getting Started

This topic describes how to use the Dobot Magician to complete the teaching & playback
function by saving three points in the MOVJ mode, allowing you to get the basic knowledge of the
usage of the robotic arm.

Prerequisites
e The DobotStudio has been installed. For details, see 2.2 Installing the DobotStudio.
e The Dobot Magician is powered on. For details, see 2.3 Powering On/Off the Dobot
Magician.
Procedure
Step1 Double-click the desktop shortcut to the DobotStudio.
The DobotStudio page with its beginner guide is displayed, as shown in Figure 2.14.
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Figure 2.14 The DobotStudio page with a beginner guide

ANOTE

After reading the beginner guide of the DobotStudio, click - to close it.

Step 2 Click Connect on the DobotStudio page, as shown in Figure 2.15.

The Question dialog box is displayed, as shown in Figure 2.16.

Teaching & Playback Write & Draw

Figure 2.15 Click Connect
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O Question

needs a little fime to

the initializ

Wait Link  Link Now

Figure 2.16 The Question dialog box

Step3  Click Link Now.
Because this section is for quick access to the Dobot Magician only and no high
accuracy is required.
When Connect changes to Disconnect, it means that the DobotStudio is connected
to the Dobot Magician, as shown in Figure 2.17.

LANOTE

To achieve a high accuracy of the robotic arm, click Wait Link.

Teaching & Playback Write & Draw

Figure 2.17 The DobotStudio is connected to the Dobot Magician

Step4  Use DobotStudio to accomplish a teaching & playback task.
1. Click Teaching & Playback, as shown in Figure 2.18.
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Teaching & Playback Write & Draw Blockly

QA [ E

LeapMotion LaserEngraving 3DPrinter

Figure 2.18 Click Teaching & Playback

LANOTE

After reading a beginner guide on the Teaching & Playback page, as shown in Figure
2.19, click . to close it.

Figure 2.19 Teaching & Playback page

2. Select PTP Point > MOVJ mode in the Save Point area, as shown in Figure
2.20.
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+Point

Figure 2.20 Select MOVJ motion mode

3. Press and hold the unlock button q on the Forearm to move the robotic arm

to a position such as point A, and then release the button.

In this case, the DobotStudio will save the Cartesian coordinate of point A, as
shown in Figure 2.21.

Figure 2.21 The Cartesian coordinate of point A

LONOTE:

Apart from hand-guided teaching, you can accomplish a teaching task by jogging the
Dobot Magician in the Cartesian or Joint coordinate system, as shown in Figure 2.22.
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Figure 2.22 Jog the Dobot Magician in the Cartesian or Joint coordinate system

4.  Move the robotic arm to other two locations such as points B and C by referring
to the method of creating point A above, as shown in Figure 2.23. The robotic
arm will save the Cartesian coordinates corresponding to these two points.

Figure 2.23 The Cartesian coordinates of points B and C

5. Enter 3 in Loop text box.

The robotic arm will repeat the sequence of movements for three times, as
shown in Figure 2.24.
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Figure 2.24 Enter 3 in the Loop text box

6. Click Start to perform the motions taught above, as shown in Figure 2.25.

The robotic arm will stop after playing back the steps for three times.

Figure 2.25 Click Start

+]
7. Click S8 to exit the Teaching & Playback page, as shown in Figure 2.26.
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3. Introduction

3.1 Overview

Dobot Magician is a multifunctional desktop robotic arm for practical training education,
supporting teaching and playback, blockly graphic programming, script, etc. Installed with different
end-effectors, Dobot Magician can realize interesting functions such as 3D printing, laser engraving,
writing and drawing. It also supports secondary development by various extensible 1/O interfaces,
which really makes your creativity and imagination increase without any limitation.

3.2 Appearance and Constitute

Dobot Magician consists of Abase, Rear Arm, Forearm, and end-effector, etc. Figure 3.1 shows
the appearance.

Rear Arm

Forearm

End-effector — Power button

Base

LED indicator

Figure 3.1 The appearance of Dobot Magician

3.3 Working Principle

This topic describes the workspace, principle, size and technical specifications of Dobot
Magician.

3.31 Workspace

Figure 3.2 and Figure 3.3 shows the workspace.
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Figure 3.2 Workspace of Dobot Magician (1)
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Figure 3.3 Workspace of Dobot Magician (2)
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332 Coordinate System

Dobot Magician has two types of coordinate system, the joint one and the Cartesian one, as
shown in Figure 3.4 and Figure 3.5 respectively.

Origin Coordinate (0,0,0)

Figure 3.5 Cartesian coordinate system

* Joint coordinate system: The coordinates are determined by the motion joints.

»  |f the end-effector is not installed, Dobot Magician contains three joints: J1, J2, and
J3, which are all the rotating joints. The positive direction of these joints is counter-
clockwise.

»  |f the end-effector with servo is installed, such as suction cup kit, gripper kit, Dobot
Magician contains four joints: J1, J2, J3 and J4, which are all the rotating joints. The
positive direction of these joints is counter-clockwise.

»  Cartesian coordinate system: The coordinates are determined by the base.
e The origin is the center of the three motors (Rear Arm, Forearm, base).

e The direction of X-axis is perpendicular to the base forward.
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21




@ DoBOT Dobot Magician User Guide 3 Introduction

3.3.3

*  The direction of Y-axis is perpendicular to the base leftward.
e The direction of Z-axis is vertical upward, which is based on the right hand rule.

*  The R-axis is the attitude of the servo center relative to the origin of the robotic arm,
of which the positive direction is counter-clockwise. The R-axis only exists once the
end-effector with servo is installed.

Motion Function

The motion modes of Dobot Magician include Jogging, Point to Point (PTP), ARC.

3.3.3.1

Jogging Mode

Jogging mode is the mode jogging Dobot Magician along the Cartesian coordinate system or
Joint coordinate system when teaching.

3.3.3.2

LANOTE
This topic describes jogging mode by the GUI operation of DobotStudio.

*  Cartesian coordinate system mode

Click X+, X- and Dobot Magician will move along X-axis in the negative or positive
direction.

Click Y+, Y- and Dobot Magician will move along Y-axis in the negative or positive
direction.

Click Z+, Z- and Dobot Magician will move along Z-axis in the negative or positive
direction.

Click R+, R-and Dobot Magician will rotate along R-axis in the positive or negative
direction.

ANOTICE

If the end-effector with servo is installed on the Dobot Magician, the R-axis will move
together with Y-axis, to make sure that the terminal posture relative to the origin stays
constant.

*  Joint coordinate system mode

Click J1+, J1- and control the base motor to rotate in the negative or positive
direction.

Click J2+, J2- and control the Rear Arm motor to rotate in the negative or positive
direction.

Click J3+, J3- and control the Forearm motor to rotate in the negative or positive
direction.

*  Click J4+, J4- and control the servo to rotate in the negative or positive direction.
Point to Point (PTP)

PTP mode supports MOVJ, MOVL, and JUMP, which means point to point movement. The
trajectory of playback depends on the motion mode.
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*  MOVJ: Joint movement. From point A to point B, each joint will run from initial
angle to its target angle, regardless of the trajectory, as shown in Figure 3.6.

MOVJ E

MOVL

A

Figure 3.6 MOVL/MOVJ mode

*  MOVL: Rectilinear movement. The joints will perform a straight line trajectory from
point A to point B, as shown in Figure 3.6.
e JUMP: From point A to point B, the joints will move in MOVJ mode, of which the
trajectory looks like a door, as shown in Figure 3.7.

1. Move up the lifting Height in MOVJ mode.

2. Move horizontally to a point that is above B by height.

3. Move down to point B.

Height

Figure 3.7 JUMP mode

3.3.3.3 ARC
The trajectory of ARC mode is an arc, which is determined by three points (the current point,
any point and the end point on the arc), as shown in Figure 3.8.

ANOTICE

In ARC mode, it is necessary to confirm the three points with other motion modes, and

the three points cannot be in a line.
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(8] Starting pointA and end point C (b} Starting poini:A and end point B

Figure 3.8 ARC mode

3.3.3.4 Application Scenarios
The application scenario depends on the trajectory in motion mode, as shown in Table 3.1.

Table 3.1 Application scenario

Motion mode Application scenario

MOVL If the trajectory of playback is required as a straight
line, you can choose MOVL

MOV If the trajectory of playback is not required but high
speed is required, you can choose MOVJ

JUMP If the movement of two points is required to lift
upwards by amount of height, such as sucking up,
grabbing, you can choose JUMP

ARC If the trajectory of playback is required as an arc, such

as dispensing, you can choose ARC

3.4 Technical Specifications

3.41 Technical Parameters

Name Dobot Magician
Maximum 5009
payload

Maximum reach | 320mm

Motion range Base - 90=%+90°
Rear Arm 285°
Forearm - 10=+90°

End-effector | - 90=+90°
rotation
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Maximum speed | Rotational 320s

(with 250g speed of

payload) Rear arm,
Forearm and
base

Rotational 480s

speed of
Servo
Repeated 0.2mm
positioning
accuracy

Power supply 100V-240V AC, 50/60Hz

Power in 12V/7TADC

Communication | USB, WIFI, Bluetooth

110 20 extensible 1/0 interfaces
Software DobotStudio
Working -10C~60<C
temperature
3.4.2 Sizes

Figure 3.9 shows the size of Dobot Magician and Figure 3.10 shows the size of the end
mounting hole.
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Figure 3.9 Size of Dobot Magician
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Figure 3.10 Size of end mounting hole
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4. Interface Description

4.1 |Interface Board

The interfaces of Dobot Magician are located on the back of the base and the Forearm
respectively. Figure 4.1 shows the interfaces on the back of the base, and Table 4.1 lists the

description.

-

\

@ DOBOT Peripheral Interface EI @

Reset

GP1  Stepperl = SW1

w2 sz sw2 [~

Key Communication Power

Interface

/

\@QE@@_@)

@

@ ® @

Figure 4.1 Interfaces in the base

Table 4.1 Interface Description

No. Description

1 Reset key: Reset MCU program
During resetting, the LED indicator on the base turns yellow. About 5 seconds
later, if the LED indicator turns green, it indicates that the reset is successful

2 Functional key:
. Short press: Start running offline program
. Long press for 2 seconds: Starting homing procedure

3 Communication interface/UART interface: Connect with Bluetooth, WIFI and
soon
The Dobot protocol is adopted.

4 USB interface: Connect with PC

5 Power interface: Connect with power adaptor

6 Peripheral interface: Connect with air pump, extruder, sensor and other
peripheral equipment. For details about peripheral interfaces, please see Table
4.2

Table 4.2 lists the peripheral interface description.
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Table 4.2 Peripheral interface description

Interface Description

SW1 Power interface of air pump; output 12V of controllable power

SW2 Output 12V of controllable power

Stepperl User-defined stepper interface; extruder interface (3D printing mode)

Stepper2 User-defined stepper interface

GP1 Signal interface of air pump; color sensor interface; infrared sensor interface;
user-defined general interface

GP2 User-defined general interface

Figure 4.2 shows the peripheral interface on the Forearm, and Table 4.3 lists the description of
the peripheral interfaces.

® ® e 00

SW4

A JEEL

ANALOG SW3 GP5 GP4 GP3

®

Figure 4.2 Peripheral interface in the Forearm

Table 4.3 Peripheral interface description

No. Description

1 GP3, End-effector interface; R-axis servo interface; user-defined general
interface

2 GP4, Auto levelling interface, user-defined general interface

3 GP5, Signal interface of laser engraving; user-defined general interface

4 SW3, Hot end interface (3D printing mode); Output 12V of controllable power

5 SW4, Fan interface (3D printing mode); Power interface of laser engraving;
Output 12V of controllable power

6 ANALOG, Thermistor interface (3D printing mode)
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4.2 LED Indicator

The LED indicator is located on the base, Table 4.4 lists the status description.

Table 4.4 LED indicator description

Status Description
Green On Dobot Magician works normally
Yellow On Dobot Magician is in the starting status
Blue On Dobot Magician is in the offline mode
Blue Blinking Dobot Magician is running homing procedure or auto levelling
Red On . Dobot Magician is at the limited position
. Alarm is not cleared
. Connection of 3D printing kit is abnormal

4.3 Multiplexed I/O Interface Description

The addresses of the I/O interfaces in Dobot Magician are unified. Most of 1/0 interfaces have
multiple functions, to control the peripheral equipment.

4.3.1 Multiplexed Base I/O Interface Description

4.3.1.1 Multiplexed UART Interface Description
Figure 4.3 shows the UART interface on the base, Table 4.5 lists the multiplexed 1/O

description.
EI018
A
5V RX  nRST  E2 12v
> | 3 A 4 «
> v oy, € 4
sTop
GND  TX KEY El GND
v <
EI020 EI019
Figure 4.3 UART interface
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Table 4.5 Multiplex I/O Description

1/0 addressing | Voltage Level Output PWM Level Input ADC
18 3.3V Xl - - ;
19 3.3V - - V -
20 3.3V - ; N ]

4.3.1.2 Multiplexed Peripheral Interface Description

Figure 4.4 shows the peripheral interface on the base, and Table 4.6 lists the multiplexed 1/0

description.

EIO10 EIO11 EIO12
b A 4

GND REV PWM ADC

EIO16
A

GND VALVE

................................................................................................

GND REV PWM ADC

Koy v

EIO13 EIO14 EIO15
Figure 4.4
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Table 4.6 Multiplexed 1/O Description

1/0 addressing | Voltage Level Output PWM Level Input ADC
10 5V Y - - .
11 3.3v J v - -
12 3.3v - - J -
13 5V \ - - .
14 3.3v V v J -
15 3.3v J - J J
16 12v \ - - .
17 12v \ - - -
4.3.2 Multiplexed Forearm I/O Interface Description

Figure 4.5 shows the peripheral interface on the Forearm, Table 4.7 lists the multiplexed 1/O
description.

EIOL o eeeeer Temp - R » GND
i pal
GND i@ ® o B FAN 12V » EI02
GND ‘ ...................... ....................... » z
oo /TR
: |_| p EIO3
\—/5 i 5
GND o oeeh ® & e e .. » T
5V - T et P PWM- oo » EIO04
GND s - G q @ ooreeraes P OADC e » EIOS
5V o P PWM.......... p EIO6
GND  eeveieenne . g ® O i » ADCoeeeorereeeeenns » EIO7
5V B ,,,,,,,,,,,,,, E | 3 PWINE coeemeeremeeeienn b EIO8
GND - e |-‘O e 0 o0 - s P ADC » EI09

Figure 4.5 Peripheral interface in the Forearm
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Table 4.7 Multiplexed 1/O description

1/0 addressing | Voltage Level Output PWM Level Input ADC
1 3.3V J - J J
2 12v V - - -
3 12v V - - ;
4 3.3V V v - -
5 3.3V - - V -
6 3.3v V J - -
7 3.3V - - N )
8 3.3V Xl J - -
9 3.3V V - V V
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5. Operation

5.1 Introduction to the DobotStudio

511 Function Modules

You can use the DobotStudio to control the Dobot Magician to accomplish multiple functions
such as Teaching & Playback, Write & Draw, Blockly graphic programming, and Script control,
as shown in Figure 5.1. For details, see Table 5.1.

Teaching & Playback Write & Draw

LeapMotion

w Sl

LaserEngraving 3DPrinter

Figure 5.1 The function modules on the DobotStudio page

Table 5.1 The function modules on the DobotStudio page

Function Modules

Description

Teaching & Playback

Teach the Dobot Magician how to move and then record the movement to
make Dobot Magician accomplish the recorded movements

Write & Draw Control the robotic arm to write, draw, or engrave an object using a laser

Blockly Use Blockly to program the robotic arm in a graphic programming
environment. It allows the users to drag and drop the blocks onto a workplace
to generate execute code just as intuitive and easy as a block puzzle

Script Control the robotic arm using the script commands

Leap Motion Support hand motions as input to control the robotic arm via a Leap Motion
controller

Mouse Control the robotic arm using a mouse

LaserEngraving

Engrave a bitmap image on an object using a laser

3DPrinter

Capable of 3D printing

Add More

Add more custom functions to manipulate the robotic arm.
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You can also set the Dobot Magician by clicking Setting on the DobotStudio page, for example, implement

general settings, base calibration, manual levelling, and auto levelling, as shown in Figure 5.2. For details, see Table

5.2.
©  General Setting
General Open Tutorial
Show Console When Startup
Update Device Name
ETWare Use Linear Rail V2 e
Sensor and Base
Base Calibration
Manual Levelling
Auto Levelling
Initial Pos
Jog
Playback
Write Draw
Leap Motion
Mouse
LaserEngraving
Default Cancel
Figure 5.2 The General Setting page
Table 5.2 The General Setting page
Items Description
General Set tutorial open or close, show console when startup, device name, use Linear
rail V2
Firmware Switch firmware

For example, you can switch to the 3D printer firmware to implement 3D
printing from the currently selected Dobot firmware

Sensor and Base

Set the Base Encoder and the angle sensors on the Forearm and Rear Arm

Base Calibration

Calibrate the base Encoder

Manual Levelling

Manually calibrate the angle sensors on the Forearm and Rear Arm

Auto Levelling

Automatically calibrate the angle sensors on the Forearm and Rear Arm.

Initial Pos Set the initial pose of the robotic arm.

Jog Set the jogging speed and acceleration in the Joint coordinate system and
Cartesian coordinate system

Playback Set the joint parameters, coordinate parameters, Jump parameters, handhold

teaching and LostStepParam.
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Items Description

Write Draw Set the Write & Draw function, such as speed, Junction velocity, linear
acceleration, acceleration, pen up offset and pen down position.

Leap Motion Set the parameters such as speed, scale, and performance for hand gesture
control.

Mouse Set the parameters such as speed, scale, and performance for mouse control.

LaserEngraving Set the parameters such as junction velocity, linear acceleration, acceleration,

pen down position, and DPI for laser engraving.

5.1.2 Common Areas of DobotStudio Page

The DobotStudio offers the following common areas shared by all the function modules to
control the robotic arm.

*  You can select the liner rail or an end-effector on the DobotStudio page, as shown in
Figure 5.3.

Figure 5.3 The linear rail and end-effector drop-down list

Table 5.3 The linear rail and end-effector drop-down list

Iltems Description

Linear rail When the robotic arm is connected to a linear rail, click this item to enable the rail
End-effector When the end-effector is a suction cup Kit, gripper Kit, laser kit or writing and drawing
drop-down list kit, select the corresponding kit in this list

*  You can also perform other operations on the DobotStudio page such as Setting,
Home, Emergency Stop, and viewing the versions, as shown in Figure 5.4.

Figure 5.4 Setting, Home, Emergency Stop, and viewing the versions

Table 5.4 Setting, Home, Emergency Stop, and viewing the versions

Iltems Description
Settin Set the robotic arm such as firmware upgrade, sensor and base setup. For details, please
9 refer to Table 5.2
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Items Description

Set the Dobot Magician back to its home position to get a correct reference position

Home When the Dobot Magician is moving, if its movement is hindered by an obstacle or the
stepper motors lost steps, perform the homing operation

Emergency Stop Stop the robotic arm if an emergency occurs

View the version information such as DobotStudio version, firmware version, and
hardware version

E Switch system language

With the Operation Panel on the DobotStudio page, you can teach the robotic arm to perform
a specific task such as jogging the robotic arm in the Cartesian or joint coordinate system, or

controlling a gripper, suction cup, or laser, as shown in Figure 5.5. For details, please refer to Table
5.5.

Setting Home

Operation Panel

Joint1
Joint2
Joint3

Joint4

[ ] SuctionCup

Figure 5.5 Setting the Operation Panel

Table 5.5 Setting the Operation Panel

Iltems Description
Coordinate Jog the Dobot Magician by clicking X (X+/-), Y (Y+/-), Z (Z+/-), or R (R+/-) in the
jogging Cartesian coordinate system
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Items

Description

Joint jogging

Jog the Dobot Magician by clicking J1+/-, J2+/-, J3+/-, or J4+/- in the Joint coordinate
system

Linear control

When the linear rail is enabled (see Table 5.3), click L+/- to move the robotic arm along
the rail.

Value range: 0 mm - 1000 mm

Gripper control

When the end-effector is chosen as a Gripper, you can set the gripper to open, close, or
disable in the Gripper drop-down box

Suction cup
control

When the end-effector is chosen as a Suction Cup, select SuctionCup to power on the air
pump. If unselected, the air pump is powered off

Laser control

When the end-effector is chosen as a Laser, select Laser to turn on the laser. If
unselected, the laser is turned off

Jogging speed
control

Set the jogging speed percentage
Default value: 50%
Value range: 1% - 100%

5.2 Performing Teaching & Playback Tasks

This topic introduces how to perform a teaching & playback task to suck or grab a small cube.
Because a suction cup kit or a gripper kit is required, we will explain them first.

5.21 Installing a Suction Cup Kit

A suction cup kit is the default end-effector shipped with the Dobot Magician. When using the
suction cup kit, an air pump is necessary, as shown in Figure 5.6.

SW1
+

Servo

Air tube connector

?

Suction cup —p- Air pump Air tube

Figure 5.6 A suction cup kit

Procedure
Step1 Connect the air pump’s power cable SW1 to the SW1 connector on the Dobot
Magician base’ rear panel and the signal cable GP1 to the GP1 connector, as shown
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in Figure 5.7.

0 DOBOT

Figure 5.7 Connect the air pump to the Dobot Magician

Step 2 Insert a suction cup kit into the end’s port, and fasten it with clamp fixing screw, as
shown in Figure 5.8.

I@g@wﬂy nut

Figure 5.8 Install a suction cup kit

Step3  Connect the air pump’s air tube to the air tube connector of the suction cup kit, as
shown in Figure 5.9.
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Air tube

Figure 5.9 Install an air tube

Step4 Connect the servo’s GP3 cable to the GP3 connector on the Forearm, as shown in
Figure 5.10.
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The Forearm

N

GP3 wire

Figure 5.10 Connect the servo’s GP3 cable to the GP3 connector

5.2.2 Installing a Gripper Kit

An air pump should be used with the gripper kit, as shown in Figure 5.11, to open or close the
gripper.

Figure 5.11 A gripper kit
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Procedure

Step 1  Dismantle the suction cup by unfastening its terminal strand with a 1.5mm hexagon
wrench, as shown in Figure 5.12.

=]

terminal strand

Figure 5.12 Dismantle the suction cup

Step 2 Install a gripper kit to the servo with a 2.5mm hexagon wrench, as shown in Figure
5.13.

Before

Figure 5.13 Install a gripper kit

Step3  Connect the gripper kit and an air pump to the Dobot Magician in the same way as
the suction cup kit is installed. For details, see 5.2.7 Installing a Suction Cup Kit.
Figure 5.14 shows the effect of the gripper kit installation.
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Figure 5.14 The effect of the gripper kit installation

5.2.3 Teaching & Playback Page

The Teaching & Playback page is shown in Figure 5.15. To access it, select Connect >
Teaching & Playback on the DobotStudio page.

stStudio-untitied.playback

Figure 5.15 The Teaching & Playback page

* Inboth Easy and Pro modes, you can switch between Easy and Pro modes, set loop,
speed percentage, and acceleration percentage, as shown in Figure 5.16.

Figure 5.16 Set Easy/Pro, Loop, Speed and Acceleration (Acc)
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Table 5.6 Set Easy/Pro, Loop, Speed and acceleration (Acc)

Items

Description

Easy/Pro

Click this slider to switch between Easy and Pro modes. The default is the Easy mode

Apart from all the functions in the Easy mode, the Pro mode offers multiple features such
as the offline mode and multiplexed 1/O interface

Loop

Set the loop that the robotic arm plays back the recorded steps
Default value: 1
Value range: 1 - 999999

Speed

Set the speed ratio when doing playback
Default value: 50%
Value range: 0% - 100%

acceleration
(Acc)

Set the acceleration ratio when doing playback
Default value: 50%
Value range: 0 - 100%

Exit

Exit the current Teaching & Playback page to return to the DobotStudio page

¢ Inboth Easy and Pro modes, you can save points, set the motion mode and the pause time
for a save point, as shown in Figure 5.17.

© DobotStudio-untitied playback

Figure 5.17 Set the save points, motion modes and pause time

Table 5.7 Set the save points, motion modes, and pause time

Items Description
+Point Click to create a new save point in the Save points list
Choose a PTP (point to point) Point mode or ARC Point mode. In the PTP Point mode,
Motion mode you can select MOVJ, MOVL, or JUMP mode while the ARC Point mode requires a
second point cirPoint and a finish point toPoint as well as the start point set via the PTP
Point mode
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Items Description

Pause time Set the pause time for a save point

¢ In both Easy and Pro modes, you can edit a highlighted save point such as copy, paste, cut,
switch between motion modes, modify name and coordinates, as shown in Figure 5.18.

Figure 5.18 The Save points list

Table 5.8 The Save points list

ltems Description
A right-click mouse In the right-click popup menu you can edit a highlighted save point such as copy,
operation paste, cut, insert, and delete, as shown in Figure 5.18

A double-click mouse | Double-clicking a cell to modify its value
operation

e Pro mode: To enter the Pro mode from the current Easy mode, click the Easy/Pro slider,
as shown in Figure 5.19. Apart from all the functions in the default Easy mode, the Pro
mode allows the robotic arm to run a save point each time, detect lost-steps, work in offline
mode, and perform the multiplexed I/O interface. For details, see Table 5.9.
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W 8 B © H & - O x

@ ey

Setting

3

213353
2115936 -82: 1. -213088

147.231

Figure 5.19 The Pro mode of the Teaching & Playback function

Table 5.9 The Pro mode of the Teaching & Playback function

No. Description

1 StepRun: run a save point each time in the Save points list. Before clicking StepRun, please select
a saved point.

2 Download: download the Save points list to the Dobot Magician for working in offline mode. For
details, see 5.3 Working in Offline Mode
Check Lost Step: the Dobot Magician detects if lost-steps occur in its movements. The default
threshold is 5 degrees. It should be at least 0.5 degrees. You can set the threshold by selecting
Setting > Playback > LostStepParam.

3 If Check Lost Step is selected, the robotic arm detects if the stepper motors lose steps when
moving. If unselected, no detection is performed
If the Dobot Magician detects lost-steps, it stops working, and its LED indicator turns red. In this
case, click Home to get a correct reference position

4 Multiplexed 1/0 interface: control the Dobot Magician via the 1/O interfaces such as turning on or
off the air pump

524 ARC Motion Mode

Application Scenarios

The ARC motion mode requires three points in an arc to complete the arc movement process.
In the ARC motion mode, only the second point and end point are saved while the start point is
determined by the other modes.

Prerequisites

The Dobot Magician has been powered on and connected to your computer.

Issue V1.7.0 (2019-01-09) User Guide Copyright © Yuejiang Technology Co., Ltd.
45




0 DoBOT Dobot Magician User Guide 5 Operation

Procedure

ANOTICE

Note the following rules when saving points to prevent the robotic arm from working
outside its normal workspace.

*  Any two points cannot coincide.
e The three points cannot be in the same straight line.

*  The arc trajectory cannot exceed the Dobot Magician’s normal workspace.

For example the points A, B, and C are on the arc. Point A is the start point; Point B is the
second point; Point C is the end point, as shown in Figure 5.20.

B

Figure 5.20 The arc trajectory

Step1 Click Teaching & Playback.
The Teaching & Playback page is displayed.
Step 2  Save the start point A.

1. Select MOVJ motion mode in the Save Point area.

2. Click I to display the Operation Panel, as shown in Figure 5.21.

©  DobotStudio-untitled playback w =2 BE @ H & - 0

®

Setting

Figure 5.21 Display the Operation Panel
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Set the jogging speed percentage to 50 on the Operation Panel.

Jog the Dobot Magician in the Cartesian or Joint coordinate system to move the
robotic arm to a location called position A.

Click +Point to save the coordinate corresponding to the position A, as shown
in Figure 5.22.

Figure 5.22 Save the start position A

Step3  Save the second point B and the end point C.

1.

Select cirPoint to save the second point in the Save Point area.

2. Jogging the Dobot Magician in the Cartesian or Joint coordinate system to move
the robotic arm to the second position B as required.

3. Click +Point to save the coordinate corresponding to the position B. In this case,
the DobotStudio automatically changes the motion mode to toPoint to get ready
to save the end position.

4. Jogging the Dobot Magician in the Cartesian or Joint coordinate system to move
the robotic arm to the end position C as needed.

5. Click +Point to save the coordinates corresponding to the positions B and C, as
shown in Figure 5.23.
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Figure 5.23 Save the second position B and the end position C

Step 4  Set the percentage of both speed and acceleration for playback, for example 50.
Step5 Set Loop to 2.

Step 6  Click Start. The Dobot Magicin perfrom the sequence of ARC trajectory as taught
from its memory system, moving from positions A through C, as shown in .

Figure 5.24 Move the small cube in the ARC motion mode

5.2.5 Teaching & Playback Example

Application Scenarios

You can use Teaching & Playback function module to manipulate the Dobot Magician to
accomplish different tasks such as transportation or intelligent sort. This topic introduces how to
move small cubes from position A to B in the JUMP motion mode.

Prerequisites
*  The Dobot Magician has been powered on and connected to your computer.
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*  Asuction cup kit has been installed. For details, see 5.2.1 Installing a Suction Cup Kit.
Procedure

Step1 Choose SuctionCup as the end-effector on the DobotStudio page, as shown in
Figure 5.25.

Write & Draw

[ 1)
w e

LeapMotion LaserEngraving 3DPrinter

Figure 5.25 Choose SuctionCup as the end-effector

Step2  Click Teaching & Playback.
The Teaching & Playback page is displayed.

NOTE
After reading the beginner guide of the DobotStudio, click . to close it.

Step3  Save the start point A.
1. Putasmall cube on the work surface near the suction cup Kit.

2. Select the MOVJ motion mode in the Save Point area.

3. Click l to display the Operation Panel, as shown in Figure 5.26.
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+Point

Figure 5.26 Display the Operation Panel

4.  Set the jogging speed percentage to 50 on the Operation Panel.
NOTE

To change the jogging speed, select Setting > Jog to set the speed and acceleration of the
joints, linear rail, or the Cartesian coordinate system, as shown in Figure 5.27.

©  Jog Setting

General Joint  Coordinate

Update

Firmware

Sensor and Base

Base Calibration

Manual Levelling

Auto Levelling

Initial Pos
Jog
Playback

Write Draw

LaserEngraving
Default

Figure 5.27 Adjust the jogging speed
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ANOTICE

Regarding the jogging speed and acceleration in the Joint coordinate system and
Cartesian coordinate system, we recommend that it should be less than 500mm/s if loaded
and that less than 800mm/s if not loaded.

5. Jog the Dobot Magician in the Cartesian or Joint coordinate system to move the
suction cup close enough to the small cube for picking-up. For example, the
suction cup reaches this location called position A.

6. Select SuctionCup on the Operation Panel to turn on the air pump to pick up
the small cube.

7. Set the PauseTime to 1 second in the Save Point area.

8.  Click +Point to save the coordinate corresponding to the position A, as shown
in Figure 5.28.

Figure 5.28 Save the start position A

Step 4  Save the end point B,
1. Select the JUMP motion mode in the Save Point area.
LONOTE
To change the jogging speed percentage, drag the speed slider.

2. Set the lifting height (JumpHeight) and the maximum lifting height (Z Limit)
by selecting Setting > Playback > JumpParam, as shown in Figure 5.29.
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O Playback Setting x

General JointParam CoordinateParam JumpParam Handhold Teaching LostStep®er

Update JumpHeight 20.00
JumpSetting
Z Limit 100.00

Firmware

Sensor and Base
Base Calibration
Manual Levelling
Auto Levelling

Initial Pos

Jog

Write Draw
Leap Motion
Mouse

LaserEngraving
Default

Cancel

Figure 5.29 Jump parameters

3. Jogging the Dobot Magician in the Cartesian or Joint coordinate system to move
the small cube to the end position B as required.

4. Unselect SucktionCup to turn off the air pump to release the small cube.

5. Click +Point to save the coordinate corresponding to the position B, as shown
in Figure 5.30.

Figure 5.30 Save the end position B

Step 5  Set the percentage of both speed and acceleration for playback, for example, 50.
LAONOTE

To change the speed and acceleration of playback, select Setting > Playback >
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JointParam/CoordinateParm to adjust the speed and acceleration of the Cartesian or
Joint coordinate system, as shown in Figure 5.31. For details, see Table 5.10.

Sensor and Base
Base Calibration

Manual Levelling

2 Playback Setting x

General JointParam CoordinateParam JumpParam Handhold Teaching LostStep®en

joint1Velc

Update

Firmware

Auto Levelling |Acceleration

Initial Pos

Jog
Playback
Write Draw
Leap Motio
Mouse

LaserEngraving

B EN Ok Cancel

Figure 5.31 Set the speed and acceleration of the playback

Table 5.10 Set the Playback

Items

Description

JointParam

Set the speed and acceleration of the joints

CoordinateParam | Set the speed and acceleration in the Cartesian coordinate system

JumpParam Set the Jump height and Z limit, which are required in the JUMP motion mode

Handhold Enable or disable the handhold teaching.

Teaching Automatically save a point when releasing the unlock button ‘D or pressing this button
LostStepParam Set the lost-step checking threshold

ANOTICE

We recommend that the motion range of Joint 1 should be 60° to -90° , the motion
range of Joint 2 should be 0° to 85° , the motion range of Joint 3 is -5° to 85° , and
the motion range of Joint 4 is -90° to 90° .

Step 6 Set Loop to 2.
Step 7 Place the small object back to the position A, and click Start. The Dobot Magician
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performs the sequence of JUMP trajectory as taught from its memory system, moving

the small cube from positions A through B.

Figure 5.32 Move the small cube in the JUMP motion mode

5.3 Working in Offline Mode

Offline mode allows the Dobot Magician to perform the points in the Save points list previously
downloaded from the DobotStudio without keeping the USB connection established.
Prerequisites

e The Dobot Magician has been powered on.

e The Dobot Magician has been connected to the DobotStudio.

e The points have been saved.
Procedure

Step1  Click the Easy/Pro slider to enter the Pro mode on the Teaching & Playback page.

Step 2 Click Download.

The Question dialog box is displayed, asking if you want the Dobot Magician to
automatically to go back to its homing point before performing the save points in the
offline mode, as shown in Figure 5.33.
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O DobotStudio-untitled.pl

oK Cancel

Figure 5.33 Click Download

Step3  Click OK to download the Save points list.

When the process bar at the bottom of the DobotStudio page shows 100% and then
disappears, it means that the download is complete, as shown in Figure 5.34.

©  DobotStudio-untitled playback

(-

ELO0L Input

Figure 5.34 The process bar at the bottom of the DobotStudio page

Step 4  Disconnect the DobotStudio from the Dobot Magician or the USB cable between the

robotic arm and your computer.
Step 5 Short press the Key button once on the base’s rear panel.

Step 6 The Dobot Magician returns to its homing point and performs the downloaded save
points. To stop the robotic arm’s movement, short press the Key button once.
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ANOTICE

Before using offline mode, Dobot Magician needs to be reset by clicking Home to make Dobot

Magician more accurate. For the details please refer to Appendix A Dobot Magician Homing
Operation

5 Operation

If press down Key button for long time, Dobot Magician will execute homing operation
directly.

5.4 Writing and Drawing
Figure 5.35 shows the process of writing and drawing.

Start
Install a writing Kit

Connect the DobotStudio

Import an image file and
set writing parameters

Adjust the position of
the pen nib and start
to write

End

Figure 5.35 The process of writing and draw

541 Installing a Writing and drawing kit

A writing and drawing kit consists of a pen and a pen holder. For detailed steps, see below.
Step 1  Install a pen in the pen holder.

Step 2 Fasten the writing and drawing kit to the Dobot Magician’s end with clamp fixing
screw, as shown in Figure 5.36.
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LVJ Clamp fixing screw

Figure 5.36 Install a writing and drawing kit

LANOTE
To change to a new pen, unfasten the four M3*5 set screws in the pen holder with a
1.5mm hexagon wrench, as shown in Figure 5.37.

=N
(D) = (s
am —» <4— ([

Figure 5.37 Change to a new pen

Step3  Position a sheet of paper on the work surface within the workspace of the Dobot

Magician,
5.4.2 Connecting the DobotStudio

Step 1  Launch the DobotStudio, and select the COM port, and then click Connect.
If the current firmware of the Dobot Magician is the 3D Printing firmware instead of
the Dobot firmware, the Select tool dialog box is displayed, asking if you want to
switch to the Dobot firmware. In this case, perform the following steps to switch to
this firmware.
1. Select DobotStudio to upgrade the Dobot firmware, as shown in Figure 5.38.
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The dialog box is displayed.

o Select tool

Current firmware is for 3D Printing!

Do you want to switch tool?

3D Printing
DobotStudio

Figure 5.38 Select the DobotStudio to upgrade the Dobot firmware

2. Click OK, as shown in Figure 5.39.
The Dobot firmware upgrade window is displayed.

2 Question

Figure 5.39 Confirm the firmware upgrade

3. Click Confirm to upgrade the Dobot firmware, as shown in Figure 5.40. When
the upgrade process bar shows 100%, and a short beep sound is heard, it means
that the firmware is upgraded successfully, as shown in Figure 5.41. In this case,
the LED indicator turns from red to green. Then click Quit to exit.

4l Dobot Frimware @
>

Current

Burning

Status: Ready to update firmware

Confirm

Figure 5.40 Click Confirm
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Ml Dobot Frimware <

Current Firmv

Burning Firmw

Status: Firmware update succeeded

Complete

Figure 5.41 The firmware upgrade is successful

AWARNING

During the firmware upgrade, do not stop it. Otherwise, errors occur.

Step 2 Click Connect on the DobotStudio page to connect the DobotStudio to the Dobot
Magician,

Step3  Click Write & Draw, as shown in Figure 5.42.

> A _
¥ & &2

Teaching & Playback Write & Draw Blockly Script

vV 8

P

LeapMotion LaserEngr g 3DPrinter

Figure 5.42 Click Write & Draw

Step 4  Choose Pen as the end-effector on the Write & Draw page, as shown in Figure 5.43.

Issue V1.7.0 (2019-01-09) User Guide Copyright © Yuejiang Technology Co., Ltd.
59




0 DoBOT Dobot Magician User Guide 5 Operation

Teaching & Playback Write & Draw Blockly

.

LeapMotion Mouse LaserEngraving 3DPrinter

Figure 5.43 Choose Pen as the end-effector

543 Importing Image Files and Setting Writing Parameters

When performing a write & draw task, a built-in or custom image file is required. Only a PLT
or SVG image can be used. The built-in file is located in the directory Installation Directory
\DobotStudio\config\prefab\system\source.

Prerequisites
APLT or SVG image file has been created.
Procedure

Step1 Click Write & Draw on the DobotStudio page, as shown in Figure 5.44.

2% 4 2

Teaching & Playback Write & Draw Blockly Script

vy ©

LeapMotion Mouse serEngraving 3DPrinter

Figure 5.44 Click Write & Draw

Step 2 Import an image file using one of the following methods.

ANOTICE
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The imported image should be placed within the annular area on the Write & Draw page,
as shown in Figure 5.45. If not, the robotic arm reaches its limited position and cannot
draw or write. In this case, the image is highlighted with a red border, as shown in Figure
5.46.

Figure 5.45 The PLT or SVG image is located within the annular area

Figure 5.46 The PLT or SVG image is located outside the annular area

o Click Open on the Write & Draw page to import a built-in PLT or SVG image file from
the DobotStudio installation directory
InstallatonDirectory\DobotStudio\config\prefab\system\source, as shown in Figure
5.47. You can also import your custom PLT or SVG image file.
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Figure 5.47 Open a PLT or SVG system image file
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o Click a shape in the Input Shapes area, as shown in Figure 5.48.

Figure 5.48 Insert a system image file

e Click Input Texts on the Write & Draw page to input texts, and set its style, and then click
OK to display the text on the annular area, as shown in Figure 5.49.

DobotMagician
.
L2

Figure 5.49 Input text

¢ Click Open to import an image file such as BMP, JEPG, or PNG to convert this image to
its corresponding SVG file that the DobotStudio supports, as shown in Figure 5.50. Once
this image is imported, the SVG Converter dialog box is displayed, as shown in Figure
5.51. In this dialog box, drag the slider to set the black and white threshold, and click
Convert Bitmap To SVG to perform the conversion, and then click Plot to Main Scene
to display the converted SVG file on the annular area of the Write & Draw page.
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Figure 5.50 Import an image

O Svg Converter

Note that only laser kit
support original format.If you
want to use pen or any other
servo driven kit please convert
bitmap into SVG path.

DOBOT MAGICIAN

ALL-IN-ONE EDUCATIONAL ROBCT, TAKE THE
MAGIC TO YOUR CLASSES!

LEARN MORE

Figure 5.51 Convert an image to SVG

ANOTICE

After image is converted to SVG, if there are single colors and fewer lines in image, you
need to adjust threshold, otherwise picture can’t be uploaded to DobotStudio.

O Svg Converter

Note that only laser kit
support original format.If you
want to use pen or any other

@ Error servo driven kit please convert
bitmap into SVG path.

Compare

Reload Bitmap

Plot to Main Scene

Figure 5.52 Error tip
Step3  Set the writing parameters.
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1. Click Setting on the Write & Draw page, as shown in Figure 5.53.

Figure 5.53 Click Setting

2. Click Write & Draw to set the Dobot Magician’s Velocity (mm/s), junction
velocity (JunctionVel: mm/s), PlanAcc (mm/s?), acceleration (Acc: mm/s?),
PenUpOffset (mm), PenDown (mm), as shown in Figure 5.54.

LAONOTE

We recommend to set the Velocity in the range of Omm/s to 500mm/s and to adjust the
acceleration between Omm/s? and 500mm/s?.

©  Draw Setting

General

Update

Firmware

5 PenDown
Sensor and Base

Base Calibration
Manual Levelling
Auto Levelling

Initial Pos

Jog
Playback
Write Draw
Leap Motion
Mouse

LaserEngraving

Default Apply O Cancel

Figure 5.54 Setting the parameters of the Write & Draw function
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5.4.4  Adjust the Position of the Pen Nib

Procedure

Step1 Raise and lower the position of the pen nib.

Press and hold the unlock button ‘D on the Forearm to move the Dobot Magician

to raise and lower the pen nib until it slightly squeezes the paper. You can also jog
the robotic arm in the Cartesian or Joint coordinate system to slowly pull the Z axis
down to a suitable vertical position for writing, as shown in Figure 5.55.

Figure 5.55 Adjust the position of the pen nib

LINOTE
The point marked by a red box, as shown in Figure 5.56, corresponds to the position of
the writing and drawing kit of the Dobot Magician. This point changes its position only
within the annular area when the robotic arm moves.

Figure 5.56 The point corresponding to the laser kit of the robotic arm
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Step 2 Click AutoZ on the Write & Draw page to obtain and save the current value of the
Z axis,
Once this step is complete, the next time you start to write, directly import a PLT or

SVG image file without adjusting the position of the pen nib, and click SyncPos, and
then click Start to start writing on the paper, as shown in Figure 5.57.

DobotMagician
.

-

Figure 5.57 Lock the height of writing

LANOTE

The value of the Z axis is the PenDown parameter. This parameter can be set by selecting
Setting > Write Draw > PenDown on the Write & Draw page, as shown in Figure 5.58.
If the effect of writing is not satisfactory, slightly raise and lower the height of the writing
and drawing kit or directly change the value of PenDown.

©  Draw Setting

General

Update

Firmware

20.0000
20.0000

Sensor and Base
Base Calibration
Manual Levelling
Auto Levelling

Initial Pos

Jog
Playback
Write Draw
Leap Motion
Mouse

LaserEngraving

Default Ok Cancel
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Figure 5.58 The PenDown parameter

Step3  Click SyncPos.

The Dobot Magician automatically moves above the position (PenDown) of the start
point of the text.

Step 4  Click Start to start writing on the paper.
When writing, click Pause to pause the writing and Stop to halt the writing.

5.5 Performing Laser Engraving Tasks

Figure 5.59 shows the process of laser engraving.

Start

Install a laser kit

Connect the DobotStudio

Import an image file and
set engraving parameters

Adjust the laser focus
and start to engrave

End

Figure 5.59 The process of laser engraving

ANOTICE

The LaserEngraving is different is from the grayscale engraving. The former uses the
same firmware and DobotStudio function module as those of the Write & Draw
function, and it can only engrave a vector graphics by drawing lines while the latter can
engrave a grayscale image. For more information about the grayscale engraving, see 5.6
Engraving a Grayscale Image.

5.51 Installing a Laser Kit

Procedure
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A laser kit includes a laser. For detailed steps, see below.

Step 1  Fasten the laser kit to the Dobot Magician's end with clamp fixing screw, as shown
in Figure 5.60.

Clamp fixing screw

Figure 5.60 Fasten the laser with clamp fixing screw

Step 2 Connect the laser’s power cable to the SW4 connector on the Forearm and the TTL
control cable to the GP5 connector, as shown in Figure 5.61.
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TTL control cable

Figure 5.61 Connect the laser to the SW4 and GP5 connectors

5.5.2 Connecting the DobotStudio

Step1 Launch the DobotStudio, and select the COM port, and then click Connect.

If the current firmware of the Dobot Magician is the 3D Printing firmware instead of
the Dobot firmware, the Select tool dialog box is displayed, asking if you want to
switch to the Dobot firmware. In this case, perform the following steps to switch to
this firmware.

1. Select DobotStudio to upgrade the Dobot firmware, as shown in Figure 5.62.
The Question dialog box is displayed.

o Select tool

Current firmware is for 3D Printing!

Do you want to switch tool?

3D Printing
DobotStudio

Figure 5.62 Select the DobotStudio to upgrade the Dobot firmware
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2. Click OK, as shown in Figure 5.63.
The Dobot firmware upgrade window is displayed.

0 Question

Cancel

Figure 5.63 Confirm the firmware upgrade

3. Click Confirm to upgrade the Dobot firmware, as shown in Figure 5.64. When
the upgrade process bar shows 100% and a short beep sound is heard, it means
that the firmware is upgraded successfully, as shown in Figure 5.65. In this case,
the LED indicator turns from red to green. Then click Complete to exit.

Dobot FM
com7

Current Firmware: Unknow
Burning Firmware:Dobot-V3.4.0

Checking connection...
Connection is well.

Confirm Quit

Figure 5.64 Click Confirm
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Al Dobot Frimware -

Current Firmw

Burning Fir

Status: Firmware update succeeded

Complete

Figure 5.65 The firmware upgrade is successful

AWARNING

During the firmware upgrade, do not stop it. Otherwise, errors occur.

Step 2 Click Connect on the DobotStudio page to connect the DobotStudio to the Dobot
Magician,

Step3  Click Write & Draw module function, as shown in Figure 5.66.

LeapMotion ase ng 3DPrinter

Figure 5.66 Click Write & Draw

Step4 Choose Laser as the end-effector, as shown in Figure 5.67.
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Teachi

¥ Advanced

Figure 5.67 Choose Laser as the end-effector

5.5.3 Importing Image Files and Setting Engraving Parameters
When performing a laser-engraving task, a built-in or a custom image file is required. Only a
PLT or SVG image can be used. The built-in image file is located in the directory:
Installation Directory\DobotStudio\config\prefab\system\source.
Prerequisites
APLT or SVG image file has been created.
Procedure

Step1  Click Write & Draw on the DobotStudio page, as shown in Figure 5.68.

21 ¥ 4 2

Teaching & Playback Write & Draw Blockly

v 8

LeapMotion LaserEngraving 3DPrinter

Figure 5.68 Click Write & Draw

Step 2 Import an image file using one of the following methods.

ANOTICE

The imported image should be placed within the annular area on the Write & Draw page,
as shown in Figure 5.69. If not, the robotic arm reaches its limited position and thus
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cannot engrave on an object. In this case, the image is highlighted with a red border, as

shown in Figure 5.70.

Figure 5.69 The PLT or SVG image is located within the annular area

Figure 5.70 The PLT or SVG image is located outside the annular area

e Click Open on the Write & Draw page to import a built-in PLT or SVG image file from
the DobotStudio installation directory
InstallatonDirectory\DobotStudio\config\prefab\system\source, as shown in Figure
5.71. You can also import your custom PLT or SVG image file.
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Figure 5.71 Open a PLT or SVG file

e Click a shape in the Input Shapes area to directly import a system image file, as shown in
Figure 5.72.

Figure 5.72 Insert a system image file

o Click Input Texts on the Write & Draw page to input texts, and set its style, and then click
OK to display the text on the annular area, as shown in Figure 5.73.
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DobotMagician
A

Al @ Open Sug/Bmp/Png/lpg/plt/drf/dobot

« © || ThEPC 5 Desitop » Imager

Organize = Newfolder

# Quick sccess

Figure 5.73 Input text

Click Open to import an image file such as BMP, JEPG, or PNG to convert this image to
its corresponding SVG file that the DobotStudio supports, as shown in Figure 5.74. Once
this image is imported, the SVG Converter dialog box is displayed, as shown in Figure
5.75. In this dialog box, drag the slider to set the black and white threshold, and click
Convert Bitmap To SVG to perform the conversion, and then click Plot to Main Scene
to display the converted SVG file on the annular area of the Write & Draw page.

& Dobot Magician.png 5

3 Drophbox

& OneDrive

I This PC

& Network

Figure 5.74 Import an image file
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©  Svg Converter

Note that only laser kit
support original format.If you
want to use pen or any other
servo driven kit please convert
bitmap into SVG path.

DOBOT MAGICIAN

ALL-IN-ONE EDUCATIOMNAL ROBOT, TAKE THE
MAGIC TO YOUR CLASSES!
Svg Convi
Thresh Hold(%;
LEARN MORE
0.4

Convert Bitmap To SVG

Reload Bitmap

Figure 5.75 Convert Bitmap to SVG

Step 3  Set the laser-engraving’s parameters.

1. Click Setting on the Write & Draw page, as shown in Figure 5.76.

Figure 5.76 Click Setting

2. Click Write & Draw to set the Dobot Magician’s Velocity (mm/s), junction
velocity (JunctionVel: mm/s), PlanAcc (mm/s?), acceleration (Acc: mm/s?),
PenUpOffset (mm), PenDown (mm), as shown in Figure 5.77.

LINOTE

We recommend to set the Velocity in the range of Omm/s to 500mm/s and to adjust the

acceleration between Omm/s? and 500mm/s?.
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O Draw Setting

General

ke Ju nVel

PlanAcc

Firmware
Acc

PenUpOffset
Sensor and Base
Base Calibration
Manual Levelling
Auto Levelling

Initial Pos

Jog

EWLET

Mouse

serl ravi A &
LaserEngraving Default Apply Cancel

Figure 5.77 Setting the parameters of the Write & Draw function

5.5.4  Adjust the Laser Focus and Start to Grave

Procedure

Step1 Choose Laser as the end-effector on the Write & Draw page, as shown in Figure

5.78.

Figure 5.78 Choose Laser as the end-effector

Step2 Click l to display the Operation Panel, and then select Laser to turn on the laser,

as shown in Figure 5.79. In this case, the laser gives out a laser beam.
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Figure 5.79 Turn on the laser

*  When using a laser, wear lasing protective eyeglass.

*  Never aim the laser at a person’s eye and clothes or stare at the laser from
within the beam.

* In the central laser focus, a high temperature heat is created and can burn
materials such as papers and wooden boards.

*  Never aim the laser at a person and their clothes.

* Do notallow the children to play with the Dobot Magician. Monitor the robotic
arm while it is running and power off it once the movement is complete.

Step3  Press and hold the unlock button ‘D on the Forearm to move the robotic arm to

raise and lower the height of the laser kit until the laser is the brightest with a smallest
possible spot size. When the laser power level is high enough, the laser beam can

burn and cut the paper. After getting a pretty good focus, unselect Laser on the

Operation Panel page to turn off the laser, as shown in Figure 5.80.

Figure 5.80 Unselect the Laser

&NOTICE

* If you cannot set the laser to be at its minimum focus, it’s probably because the focal
length is long. To shorten the focal length, slightly turn the sliver lens screw (as
shown in Figure 5.81) on the bottom of the laser kit.
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Figure 5.81 Adjust the laser focus

e The point marked by a red box, as shown in Figure 5.82, corresponds to the position
of the end-effector of the Dobot Magician. This point changes its position only within
the annular area when the robotic arm moves.

Figure 5.82 The point corresponding to the end-effector of the robotic arm

Step 4  Click AutoZ on the Write & Draw page to obtain and save the current value of Z
axis,
Once this step is complete, the next time you start to engrave, directly import a PLT

or SVG image file without adjusting the position of the laser kit, and click SyncPos,
and then click Start to start engraving on the paper, as shown in Figure 5.83.
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Figure 5.83 Lock the height of engraving

LONOTE

The value of the Z axis is the PenDown parameter. This parameter can be set by selecting
Setting > Write Draw > PenDown on the Write & Draw page, as shown in Figure 5.84.

If the effect of engraving is not satisfactory, slightly raise and lower the height of the laser
kit or directly change the value of PenDown.

O Draw Setting

General

Update

Firmware

PenUpOffset

£ Pen
Sensor and Base

Base Calibration
Manual Levelling
Auto Levelling

Initial Pos

Jog

Playback

Leap I
Mouse

LaserEngraving

Default

Figure 5.84 Set the PenDown parameters
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Step5  Click SyncPos.

The Dobot Magician automatically moves above the position (PenUpOffset) of the
start point of the laser-engraving.

Step 6  Click Start to start engraving on the paper.
When engraving, click Pause to pause the engraving and Stop to halt the engraving.

Figure 5.85 shows the effect of the laser-engraving.

Figure 5.85 The effect of the laser-engraving

5.6 Engraving a Grayscale Image

Figure 5.86 shows the process of engraving a grayscale image.
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Start

Install a laser kit

Connect the DobotStudio

Import an image and set
engraving parameters

Adjust the laser focus
and start to engrave

End

Figure 5.86 The process of engraving a grayscale image

5.6.1 Installing a Grayscale-engraving Kit

Both grayscale-engraving and laser-engraving use the laser kit as the end-effector. For the
installation method, see 5.5.1 Installing a Laser Kit.

5.6.2 Connecting the DobotStudio

Step1 Launch the DobotStudio, and select the COM port, and then click Connect.

If the current firmware of the Dobot Magician is the 3D Printing firmware instead of
the Dobot firmware, the Select tool dialog box is displayed, asking if you want to
switch to the Dobot firmware. In this case, perform the following steps to switch to
this firmware.

1. Select DobotStudio to upgrade the Dobot firmware, as shown in Figure 5.87.
The Question dialog box is displayed.
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o Select tool

Current firmware is for 3D Printing!

Do you want to switch tool?

3D Printing
DobotStudTo

Figure 5.87 Select the DobotStudio to upgrade the Dobot firmware

2. Click OK, as shown in Figure 5.88.
The Dobot firmware upgrade window is displayed.

0 Question

Figure 5.88 Confirm the firmware upgrade

3. Click Confirm to upgrade the Dobot firmware, as shown in Figure 5.89. When
the upgrade process bar shows 100%, and a short beep sound is heard, it means
that the firmware is upgraded successfully, as shown in Figure 5.90. In this case,
the LED indicator turns from red to green. Then click Complete to exit.

Dobot FM
COMm7

Current Firmware: Unknow
Burning Firmware:Dobot-V3.4.0

Checking connection...
Connection is well.

Confirm Quit

Figure 5.89 Click Confirm
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plll Dobot Frimware v

Burning F

Status: Firmware update succeeded

Complete

Figure 5.90 The firmware upgrade is successful

AWARNING

During the firmware upgrade, do not stop it. Otherwise, errors occur.
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Step2  Click LaserEngraving, as shown in Figure 5.91.

& |

Teaching & Playback Write & Draw Blockly

w Al

LeapMotion LaserEngraving

Figure 5.91 Click LaserEngraving

3DPrinter

5.6.3 Importing Image Files and Setting Engraving Parameters

Prerequisites

An image file has been created. You can also import system image, the importing path is

Installation Directory\DobotStudio\attachment\grbrMode\source.

Procedure

ANOTICE

The imported image should be placed within the annular area on the LaserEngraving

page, as shown in Figure 5.92. If not, the robotic arm reaches its limited position and thus

cannot engrave on an object. In this case, the image is highlighted with a red border, as

shown in Figure 5.93.
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Figure 5.92 The image file is located within the annular area

Figure 5.93 The image file is located outside the annular area

Step 1  Choose Laser as the end-effector on the LaserEngraving page, as shown in Figure
5.94.

J SuctionCup

£ Gripper

/ Pen

? Advanced

Figure 5.94 Choose Laser as the end-effector
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Step 2 Click Open to import an image file such as BMP, JPEG, or PNG, as shown in Figure
5.95.

® &

Home

Stop

@ Cpen Bmp/Png/lpg

X
« “ 4 > ThisPC > Desktop > Laserengraving v O Pl
Organize v Mew folder =- m @
& Quick sccess ﬁ
33 Dropbox “.
@ OneDrive o b
& This PC One piece.png
o Network:
o
%
File name: ~| [:bmp-png jpo"bmp "png ~ji v
Figure 5.95 Import an image file
@ Open Svg/Bmp/Png/lpg/plt/did/dobot x
4 || « ProgramFiles » DobotStudio » DobotStudie » attachment > grbiMede » source v @/ | search source »
Organize + New folder =~ @ @

B 30 Objects ~

I Desktop ‘é? a S 4.

%] Dacuments v By, = ﬁi--’ ! il v\ = L flisy

& Downloads ! LS ) n o V3 N
1 ' "

. P i

& Music fileljpg file2jog file3 jpg filed jpg file7 jpg filegjpg filed,pg
&= Pictures ® './.

B videos W

i Windows7_0S (¢

— Data2 (D) “

= New Volume (E) file10jpg fileT pg

- LIEEE )

Z¥ Lenovo_Recover

¥ Network

v

File name: |filed,jpg v| svg bmp .png jpg plt ixf .do

Eare]

Figure 5.96 System image

Step3  Set the Grayscale range, Laser power range, and Border, as shown in Figure 5.97,
For details, see Table 5.11.

Open

Figure 5.97 Set the grayscale range, laser power range, and border
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Table 5.11 Laser engraving parameters

Items Description
Grayscale range Set the grayscale range
Range: 0 - 255

Default value: 20 - 240

Laser power range Set the laser power range
Range: 2 - 100

Default value: 20 - 90

Border Set the border width.
Unit: pixel
Range: 0 - 50

Default value: 4

Step 4  Set the laser-engraving parameters.
1. Click Setting on the LaserEngraving page.

2. Set the JunctionVel (junction velocity), PlanAcc (linear acceleration), and Acc
(acceleration), for example, set all to 5, as shown in Figure 5.98.

O Laser Setting

General ] 5.0000

Update . 5.0000

5.0000

-10.0000 =
181.0099 e

Firmware

Base Calibration
Manual Levelling
Auto Levelling

Initial Pos

Mouse

LaserEngraving Default Ok Cancel

Figure 5.98 Set the parameters of laser engraving

5.6.4  Adjustthe Laser Focus and Start to Engrave
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Step1 Click l to display the Operation Panel, and then select Laser to turn on the laser,

as shown in Figure 5.99. In this case, the laser gives out a laser beam.

A Danger

When using a laser, wear lasing protective eyeglass.

Never aim the laser at a person’s eye and clothes or stare at the laser from
within the beam.

In the central laser focus, a high-temperature heat is created and can burn
materials such as papers and wooden boards.

Never aim the laser at a person and their clothes.

Do not allow the children to play with the Dobot Magician. Monitor the robotic
arm while it is running and power off it once the movement is complete.

Operation Panel

Figure 5.99 Select the Laser

Step2  Adjust the laser focus.

Press and hold the unlock button 3 on the Forearm to move the robotic arm to

raise and lower the height of the laser kit until the laser is the brightest with a smallest
possible spot size. When the laser power level is high enough, the laser beam can
burn and cut the paper. After getting a pretty good focus, unselect Laser on the
Operation Panel page to turn off the laser, as shown in Figure 5.100.
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Operation Panel

Figure 5.100 Unselect the Laser

ANOTICE

¢ |f you cannot set the laser to be at its minimum focus, it’s probably because the focal
length is long. To shorten the focal length, slightly turn the sliver lens screw (as
shown in Figure 5.101) on the bottom of the laser kit.

Figure 5.101 Adjust the focus

¢ The point marked by a red box, as shown in Figure 5.102, corresponds to the position
of the laser kit of the Dobot Magician. This point changes its position only within the
annular area when the robotic arm moves.
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®

Setting Home

®-e . . L ® . . i d
36306 281 216 -7 frn 216 28t AW

Figure 5.102 The point corresponding to the laser kit of the robotic arm

Step3  Click AutoZ on the LaserEngraving page to obtain and save the current value of
the Z axis.
Once this step is complete, the next time you start to engrave, directly import an
image file without adjusting the position of the laser kit, and click SyncPos, and then

click Start to start engraving on the paper, as shown in Figure 5.103.

Figure 5.103 Lock the height of engraving

LONOTE
The value of Z axis is the PenDown parameter. This parameter can be set by selecting
Setting > LaserEngraving > PenDown, as shown in Figure 5.104. If the effect of
engraving is not satisfactory, slightly raise and lower the height of the laser kit or directly
change the value of PenDown.
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2 Laser Setting

General
Update

Firmware

Sensor and Base

Base Calibration

Manual Levelling

Auto Levelling

Initial Pos
Jog
Playback

Write Draw

JunctionVel

PlanAcc

Acc

PenDown -10.0000

DPI 181.0098

Default Ok Cancel

Step 4

Step 5

Figure 5.104 Set the PenDown parameters

Click SyncPos.

The Dobot Magician automatically moves above the position of the start point of the
laser-engraving.

Click Start to start engraving on the paper.
When engraving, click Pause to pause the engraving and Stop to halt the engraving.

Figure 5.105 shows the effect of the laser-engraving.

o endigel

Figure 5.105 The effect of laser-engraving

5.7 Controlling with your Hand Gesture
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You can use the LeapMotion function module of the DobotStudio to perform tasks, for
example, grab or suck an object with your hand gesture.

5.71 Installing a Leap Motion Controller
Prerequisites

o The Leap Motion controller (a hand gesture controller) has been obtained.

e The Leap Motion driver software has been obtained. Download the Windows version, as
shown in Figure 5.106, from the https://www.leapmotion.com/setup/desktop/windows.

DOWNLOAD FOR WINDOWS

Dive in to the future of VR with our Orion beta software.
DEVELOPER SDK »

Or download our V2 software

for windows, Mac, or Linux.

Minimum system requirements

Figure 5.106 Download the Leap Motion driver software for Windows

Procedure

Step1  Connect a Leap Motion controller to your computer with a USB cable, and put it on
the work surface with its face up, as shown in Figure 5.107.

Figure 5.107 Connect the Leap Motion controller to your computer

Step 2 Install the Leap Motion driver software by following the on-screen instructions, as
shown in Figure 5.108.
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‘ Leap Motion Controller Setup - bt

Welcome to Leap Motion: Orion

Youare about to install the Orion beta software for the Leap
Motion Controller. This developer beta release is focused on

wvirtual reality and head-mounted displays  with greater
tracking reliability, higher accuracy, and lower latency.
- Hands in YR, starts here,

E——— |

Figure 5.108 The Leap Motion Installation Interface

5.7.2 Leap Motion Demo

You can move or sort an object with the LeapMotion function. This topic introduces how to
move a small cube with a hand gesture.

Prerequisites

*  The Dobot Magician is powered on and connected to your computer.

*  The suction cup kit has been installed. For details, see 5.2.1 Installing a Suction Cup Kit.
Procedure

Step 1  Launch the DobotStudio, and click Connect to connect to the Dobot Magician.

Step 2 Click LeapMotion, as shown in Figure 5.109,

Teaching & Playback Write & Draw Blockly Script

o U

/7%

LeapMotion Mouse LaserEngraving 3DPrinter

Figure 5.109 Click LeapMotion
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Step3  Click Setting on the DobtStudio page, as shown in Figure 5.110,

Q &

Setting Home

Stop

Figure 5.110 Click Setting

Step4  Click Leap Motion, as shown in Figure 5.111. Set the parameters, as shown in Table
5.12, and click OK.

© LeapMotion Setting
General

@ High performance @ Low performance

Firmware

Sensor and Base
Base Calibration
Manual Levelling
Auto Levelling

Initial Pos

Jog
Playback
Write Draw
Leap Motion
Mouse

LaserEngraving

Default Apply g Cancel

Figure 5.111 Set the parameters of the Leap Motion function

Table 5.12 Set the parameters of the Leap Motion function

Items Description
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Speed The velocity percentage of the Dobot Magician:
Unit: %

Value range: 1 - 100

Default value: 50

Scale The scale of the Dobot Magician:
Unit: %

Value range: 1 - 100

Default value: 100

High performance/Low Choose a performance mode suitable for your computer. Select the Low
performance performance (default) for the low configuration computer to prevent
video delay

StepS Choose SuctionCup as the end-effector on the DobotStudio page, and click Start
to control the Dobot Magician with your hand gesture, as shown in Figure 5.112. To
maintain the Dobot Magician in a stable state, move your hand into the workspace
of the Leap Motion controller while keeping your palm upward. And turn your palm
down, and then move your hand above this area to control the Dobot Magician.

Figure 5.112 Click Start

NOTE

Move your hand in the workspace of the Leap Motion controller to control the Dobot
Magician to perform a particular task, as shown in Table 5.13.

Table 5.13 The robotic arm’s movement created with your hand gesture
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Hand gesture Robotic arm’s movement

Move your palm up, down, front, The robotic arm moves accordingly
back, right, or left

Clench your fist Control the air pump to suck air
Unclench your fist Turn off the air pump

Step 6  Put a small cube on the work surface in the workspace of the Dobot Magician, such
as point A, and use the hand gesture to move robotic arm above the cube until it’s
close to the cube.

Step 7  Clench your fist to control the air pump to suck the small cube, and move your fist
to make Dobot Magician take the cube to another position while clenching your fist,
such as position B, and then unclench your fist to turn off the air pump to drop the

cube.

Step 8 Turn your palm upward and click Stop to stop the hand control.
5.8 Controlling with your Mouse

You can use the Mouse function module of the DobotStudio to perform tasks, for example,
grab or suck an object with your mouse. This topic introduces how to move a small cube with
a mouse.

Prerequisites

*  The Dobot Magician is powered on and connected to your computer.

*  The suction cup kit has been installed. For details, see 5.2.1 Installing a Suction Cup Kit.
Procedure

Step1 Click Mouse, as shown in Figure 5.113.

Teaching & Playback Write & Draw Blockly

v o

LeapMotion Mouse S £ g 3DPrinter

Figure 5.113 Click Mouse

Step2  Choose SuctionCup as the end-effector on the DobotStudio page, as shown in
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Figure 5.114.

SuetlenCup

Figure 5.114 Choose SuctionCup as the end-effector

Step3  Click Setting, as shown in Figure 5.115.

Figure 5.115 Click Setting

Click Mouse, as shown in Figure 5.116. Set the parameters, as shown in of mouse control

Table 5.14, and click OK.
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O Mouse Setting

General
Update

Firmware

Sensor and Base
Base Calibration

Manual Levelling
Auto Levelling

Initial Pos

Jog
Playback
Write Draw
Leap Motion
Mouse

LaserEngraving

Figure 5.116 Set the parameters of mouse control

Table 5.14 Set the parameters of mouse control

@ High performance @Low performance

Cancel

Parameters Description
Speed The velocity percentage of the Dobot Magician:

Unit: %

Value range: 1 - 100

Default value: 50
Scale The scale of the Dobot Magician:

Unit: %

Value range: 1 - 100

Default value: 100
High Choose a performance mode suitable for your computer. Select Low
performance/Low | performance (default) for the low configuration computer to prevent video delay
performance

Step 1  Put a small cube on the work surface in the workspace of the Dobot Magician, such

as point A,

Step 2  Press V to enable the mouse control of the Dobot Magician. Press and hold the left

mouse button to drag the mouse within the red annular area to move the robotic arm,

as shown in Figure 5.117.

ANOTICE

Do not move the mouse outside the red annular area. If not, the robotic arm reaches its
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limited position. In this case, drag the mouse to into the annular area.

Figure 5.117 Move the robotic arm in the red annular area

Step3 Move the Dobot Magician above the cube by dragging the mouse and then place it
close to the cube.

LINOTE
For details on how to use the mouse to control the robotic arm on the Mouse page, see
Table 5.15.

Table 5.15 The robotic arm’s movement created with your mouse

Mouse action Robotic arm’s movement

Move your mouse front, | The robotic arm moves accordingly
back, right, or left

Scroll the mouse wheel | The robotic arm moves accordingly
up or down

Press and hold the left Suction cup: the air pump sucks air in

mouse button Gripper: increase holding force

Release the left mouse Suction cup: the air pump is powered off

button Gripper: open
Right-click the mouse Gripper: close
button

Step 4  Press and hold the left mouse button to control the air pump to suck air to move the
mouse to drag the robotic arm to take the cube to another position, such as point B,
and release the left mouse button, and the air pump stops working to drop the cube

here.

Step S  Press V or ESC to disable the mouse control.

5.9 Operating 3D Printing
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After installing 3D printing kit, you can import 3D module into the 3D printing software for
3D printing. Figure 5.118 shows the 3D printing process.

Start

Install 3D printing
kit

Burn firmware

Perform 3D
printing

End

Figure 5.118 3D printing process

During 3D printing, the 3D printing control software is required. You can use Repetier Host
or Cura software for 3D printing.
* Reptier-Host: Reptier-Host can slice with the third party slicing (such as
CuraEngine, Slic3r, etc), check and modify G-Code, control 3D printing manually. More
parameter settings make Reptier-Host very flexible.
*  Cure: The slicing of Cura is fast and stable. It has strong inclusiveness to 3D model
structure and less parameter settings.

ANOTICE

This section uses Windows as an example to describe how to perform 3D printing with
Repetier Host and Cura. For Mac OS, only Cura is supported.

5.9.1 Installing 3D Printing Kit

3D printing kit contains extruder, hot end, motor cable, filament, and filament holder as shown
in Figure 5.119.
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Hot end

Motor Cable  fjjament

Filament Holder

T

Figure 5.119 3D printing kit

Procedure

Step1 Press down the lever on the extruder, and push down the filament to the bottom of
the hole via the pulley, as shown in Figure 5.120.
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Figure 5.120 Push down the filament

Step 2 Connec the end of the PTFE tube to the hot end and push it down to the bottom of
the hot end, and connect the other end to the extruder, as shown in

Figure 5.121 Connect extruder and hot end

Step3  Insert the filament into the PTFE tube and push it down to the bottom of the hot end.

ANOTICE

Please make sure that the PTFE tube has been pushed down to the bottom of the hot end.
Otherwise, it will cause abnormal discharge.
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Step 4  Fix the hot end on the Dobot Magician with clamp fixing screw, as shown in Figure
5.122.

Figure 5.122 Fix hot end

Step 5 Insert the heating cable to the interface 4 on the Forearm, the fan cable to the interface
5 and the thermistor cable to the interface 6, as shown in Figure 5.123.

Issue V1.7.0 (2019-01-09) User Guide Copyright © Yuejiang Technology Co., Ltd.
105




0 DoBOT Dobot Magician User Guide 5 Operation

Figure 5.123 Connect hot end to the Forearm

Step 6  Connect the extruder to the Stepper1 interface on the back of the base with motor
cable, as shown in Figure 5.124.

Figure 5.124 Connect with extruder

Issue V1.7.0 (2019-01-09) User Guide Copyright © Yuejiang Technology Co., Ltd.
106




0 DoBOT Dobot Magician User Guide 5 Operation

Step 7 Place the filament and the extruder to the filament holder, as shown in Figure 5.125.

Figure 5.125 Place filament and extruder to the Filament holder

5.9.2 Operating Repetier Host

Repeiter Host has been built into DobotStudio. After burning 3D printing firmware, the
Repetier Host page will be displayed automatically.
Prerequisites

*  The 3D printing model has been prepared.

*  The printing platform has been prepared and please place it in the workspace of the
Dobot Magician.

*  Dobot Magician has been powered on.

* Dobot Magician has been connected to DobotStudio successfully (Only USB
connection is supported).

*  The 3D printing kit has been installed.
5.9.2.1 Burning Firmware
Procedure
Step1  Click 3DPrinter on the DobotStudio page.
The 3D Printing FM page is displayed, as shown in Figure 5.126.
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3D Printing FM
com4

Current Firmwa

Burning Firmw t-V4.6.0

Status: Rea update firmware

Confirm Quit

Figure 5.126 Burn firmware

Step2  Click Confirm to start burning 3D printing firmware.
After burning 3D printing firmware, the Repetier Host page is displayed
automatically, as shown in Figure 5.127.
If the LED indicator on the base turns red, it indicates that the connection of the 3D
printing kit is abnormal.

AWARNING

Please DO NOT operate or turn off Dobot Magician when burning firmware, to avoid

machine damage.

- &

: 5 STEWTRE Easy Mode SE2E7L
o0 R B | A ek | Fore |

F@] B ORI 4

GCode EE

ORFEE OXFHER QiR

5.0 NVIDIA 372.54

:GL_AMD_multi_draw_indirect GL_AMD seamless_cubemap_per_texture GL_ARB arrays_|
zce GIX 750 Ti/ECIe/SSE2

erer:
at VEOs for rendering is pessible
= FEE bl n

- NOW@O L 4 [

mE OBMEHN @MARE o Eh |

of arrays GLi},RBibaseilnst‘:l

Figure 5.127 Repetier Host page
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ANOTICE

If the current firmware is set for 3D printing when operating 3D printing, you can click
Connect directly on the DobotStudio page. And then Click OK on the Select tool page
to switch to Repetier Host, as shown in Figure 5.128.

o Select tool

Current firmware is for 3D Printing!
Do you want to switch tool?
3D Printing

Cancel

”

Write & Draw

Figure 5.128 Switch into 3D printing automatically

5.9.2.2 Performing 3D Printing
Procedure
Step1  Set printing parameters.
Printing parameters only need to be set for the first time.
1. Click Printer Settings on the top right corner of the Pepetier Host page.
The Printer Settings page is displayed.

2. Set the corresponding parameters on the Connection tab as shown in the red box
of Figure 5.129. The other parameters are set by default.
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Printer Settings

Printer: Dobet v &
Printor Extruder | Printer Shape | Advanced
Connector: Serial Conmection v
Port: Com4 v
Baud Rate: 116200 v
Transfer Protocol: |guiodetect v
Reset on Conmect DTE low=>hi gh=>Low W

Reset on Emergency gupq emergency command and reconnect v

Receive Cache Size: |63

[[JUse PingFong Communication (Send only after ok)

The printer setting’s always correspomi to the selected printer at the top. They
are stored with every 0E or apply. To create a new printer, just enter a new
printer name and press apply. The new printer starts with the last settings
selected.

Figure 5.129 Connection setting

3. Click Apply.

4. Unselect the corresponding options on the Printer tab as shown in the red box
of, Figure 5.130 and the other parameters are set by default. Then, click Apply.
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Frinter: Dobot T i

Conner_'tionl Printer IExtruder | Printer Shape | Advanr_‘edl

Travel Feed Rate: 4800 [mm/min]

Z-hxis Feed Rate: 100 [mm/min]

Manual Extrusion Speed: 2 o [mm/=]
Manmal Retraction Speed: a0 [mm, =]

Defanlt Extruder Temperature: 200 °C

Defanlt Heated Bed Temperature: == L

Checl: Extruder & Bed Temperature

D Eemove temperature requests from Log

Check ewvery 3 seconds.

Parlk Position: X: T g T min: 0O [mm]
Send ETA to printer display Il:‘ Go to Parle Position after J'ob_."KilZI
Disable Extruder after Job/Kill Disable Heated Bed after Job/Hill
I:‘ Dizable Mators after Job/Eill I Il:‘ Frinter has 5D card I
Add to comp. Frinting Time § [4]
Inwvert Direction in Controls for D K-hxis I:‘ T-hxis I:‘ I-hxis

[ 0K ] Apply [ Cancel

Figure 5.130 Unselect options

5. Set the corresponding parameters on the Extruder tab as shown in the red box of
Figure 5.131, the other parameters are set by default. Then, Click Apply.
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Printer: Dobot M| I
Connection | Printerl Extruder IPrinter Shape Iﬁdva.ncedl

Hamber of Extruder: 1 =

Max. Extruder Temperature: 2a0

Max. Bed Temperature: 120

Max. ¥olume per second 1z [mm* f'=]

[[] Printer has a Mixing Extruder (one nozzle for all colors)

Extruder 1

Hame:

Diameter: 04 [mm] Temperature Offset: u] [*C]

Color:

Offzat X: a Off=et ¥: a [mm]

[ 0K ] [ Apply ] [ Cancel

Figure 5.131 Extruder settings

Issue V1.7.0 (2019-01-09)

6. Set the corresponding parameters on the Printer Shape tab as shown in the red
box of Figure 5.132, the other parameters are set by default. Then, Click Apply.
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Frinter: Dobot - i
| Conniection I Frinter I Extruder | Frinter Shape |Advanced|
Frinter Type: [Rostock Frinter (circular print shs v]
Home ¥: Min w | Home ¥: Min w | Home E:
Printable Radius: a0 mm
Frintable Height: 150 mm
[ 0K ][ Apply ] [ Cancel ]

Step 2

Figure 5.132 Printer shape settings

7. Click OK
Click Connect on the Repetier Host page to connect Dobot Magician.

After the connection is successful, the current heating temperature will be shown on
the below of the Repetier Host page, as shown in Figure 5.133.

[ Repetier-Host V1.0.6
File View Config Printer Tools Help

olR.@2 .0 /5 @ @&

Disconne: ct] Lload SavePrint StartPrint  Kill Print ToggleLog Show Filament Show Travel

o

D View |Temperature Curve|

s QRMO L+ +[Q

Debug Options
[@ Foha 1[5 Tofa 163 Frvere @ Trw Rom 1 [

Show in Log! @Commands  Qlnfos O

ings  OFrrors @MK  O#uto Seroll i Clear Lo (Copy

FIEMWARE_WAME:Marlin V1; Sprinter/grbl mashup for gens FIRMWARE_URL:NTTPS://github.com/ErikZalm/Marlin/ PROTOCOL_VERSTON:1.C s
K:14.10 ¥:0.00 2:-2.02 E:0.00 Count X: 0.00 ¥:68.61 2:60.50

echo:Active Extruder: 0 (|
echo:Active Extruder: 0

Connected: Dobot | Extruder: 271°croff | Idle _=;|

Figure 5.133 Connect to Dobot Magician
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Step3  Text extruder.

Before printing, you need to test the extruder to check whether the melted filament
flows from the nozzle of the extruder.

The temperature of the extruder should be above 170°C. Dobot Magician will not
start 3D printing until the filament is in the melting state. So you need to heat the
extruder first.

1. Set the heating temperature to 200°C on the Manual Control tab of the Repetier

v

Host page and click , as shown in Figure 5.134.

ADANGER

The heating rod will produce high temperature up to 250°C, please be careful. Do not let
children play with it alone. The process needs to be monitored when it is running. After
the process is completed, please turn off the equipment promptly.

(@ Repetier-Host V1.06 - o X
Fle View Config Printer Toos Help

OR.@ Pp.B / ®@ @ ® 0 ®
Disonnect  Load  Save Print StantPrint Kl it Toggle Log Show Filament Hide Travel Privter Settings Easy Mode Emergency Stop
B Vier Japerature Carve

Object Flacerent Slicer Frevier Musaal Contrel

Code: | Sed
[ ool ol ool ]

0800000060

# RS <

Figure 5.134 Heat the extruder

2. Click the extruder feeder when the heating temperature is up to 200°C and feed
up tol0mm-30mm, as shown in Figure 5.135.
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Object Placement |Slir_'er | Preview | Matmal Control

-

lEil .

Send

i

_2 nz Extruder 1

Figure 5.135 Extrude filament

If the melted filament flows from the nozzle of the extruder, the extruder is
working properly.

ANOTICE

If the filament extrusion is in the opposite direction. Please remove the filament, and turn
the extruder around, then re-push down the filament.

Step 4  Adjust the printing space and get the printing coordinates.

LONOTE
During printing, if the distance from Dobot Magician to the printing platform is too large
or too small to paste the first layer, it can lead to the nozzle blockage. For increasing the
stickiness of the first layer, placing a masking paper on the platform is recommended.

1. Press the Unlock key on the Forearm and drag Dobot Magician to make the
printing head contact the surface of the masking paper (The distance between the
printing head and the surface of the masking paper is the thickness of a sheet of
A4 paper), then release the Unlock key.

2. Input command M415 on the G-Code command window and press Enter to get
the current coordinates, as shown in Figure 5.136.
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Also, you can press the Key button on the bace of the base to get the current
coordinates.

(@ Repetier-Host V1.0 |
l)ﬂ—'& WE EE e IR #E

OB @ . B / ® @

BN EEEE BEOEE  ULEE BEEER B ERE

T WE R P | st sk | Fehinl

GCods: M415_| EiE

Sl 0,00 o ooffiithk 1~

(ON-NPN 1 N2N3NAN5N)
A eI
& CRMIIIIITIITIITETITTTITTITTTIIT 10

]

m

S Q@O L 4 +(Q

"
ahsiat]
[@rr=E 6 =8 IS (@ #reE 1 & =
TR @iLFEHY ORRERE OLREs ORRHE QRREE ogiwE) aFEHIR  ;mEW
Resend: 11 o
. CARA_OFFSET_Y1:0.00 ,SCARA OFFSET_21:15.07
®:-1.11 ¥:0.00 Z:0.000k )

EiS#: Dobot #F7H3k: 199.6/200°C EEE \—/l

Figure 5.136 Input M415

LANOTE

If you cannot find the G-Code command window, please click EASY to close Easy
Mode, as shown in Figure 5.137.

File View Config Printer Tools Help

O.b=E » B ¢a|.|@|

Connect  Load  SavePrint StartPrint  Kill Print Printer Settings| Easy Mode [mergency Stop

9D Viev |Temperature Curve|

SALE [+ R dle]

Disconnected: default - Mlef

Figure 5.137 Easy mode

Step 5  Click Load to import the prepared 3D printing model, as shown in Figure 5.138. You
can also load 3D printing model which are DobotStudio, the loading path is
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Installation directory\DobotStudio\attachment\3dModeStl,
The format of 3D model is STL. You can design 3D model and transform it into STL

format.

| ) Repetier-Host V1.0.6 B - i = = B B - == =]

|| File View Config Printer Tools Help

Blm p.B /S @ @ s @

Disconnect | Load |SavePrint StartPrint  Kill Print TeggleLog Show Filament Show Travel Printer Settings EasyMode Emergency Stop

Object Placenent | Slicer |Freview Memal Comtrcl |

30 View |Tenperature Curve|

]
&. - S)- |« 3D printing » 30 modules » - Search 30 modules
a Organize + New folder =
N "I“ |4| Documents “ Name . Date medified Type
1 Q & Music () fish_fossilz_fob 2016/5/28 10:46 STLFil
] Pictures (. Hollow_Pyramid 2013/1/918:02 STLFil
Q Subversion () pikachu_Lgen_flowalistik 2016/7/25 6:01 STLFil
1 B videos () squirtle_starter_Lgen_flowalistik 2016/10/914:08 STLFil =
g [H ereams () totodile_starter_2gen_flowalistik_2 2016/7/25 6:02
@l BETE [ totoro-solid 2016/10/9 14:08
! ﬂ | ) Twisted Vase Basic | 2013/1/9 21:01
1% Computer T Twisted_Vase_gcode.gcode 2016/9/7 20:03
@ £ windows7_05 (¢ () TwistedLamp 2013/1/101:45
a ruanjian (D) || Wolf.obj 2015/2/270:09 OBJ Fil
// s zilize () ) BERT 2016/9/2 3:00 STLFil +
al s SYSTEM_DRV (F) =« [ i ] v L
m

File name:  Twisted_Vase_Basic w |GCode/3D-Files b

Show in Log:  @Conmands

PERETTEEEIT -cho:ictive Extruder: 0O
21:16:1 IW echo:Active Extruder: 0
N SCARE OFFSET_X1:-250.00 ,SCARA_OFFSET_Y1:0.00 , SCARA_OFFSET_Z1:77.40 ]
[W x:16.26 ¥:0.00 Z:0.000k -

Connected: Dobot Bxtruder: 27.0°C/0ff Idle | E

Figure 5.138 Import 3D printing Model

After importing the model, you can center, zoom, or rotate the model on the
Object Placement page, as shown in Figure 5.139.

51/ Repetier-Host VL0 - Twisned_\llase_ﬂm_LElﬂg1

File View Config Printer Tools Help

O b.@d .0/ ® @ #2 O @

Disconnect  Load  SavePrint StartPrint  Kill Print Togglelog Show Filament Show Travel Printer Settings Easy Mode Emergency Stop
I View |Temperature Curve| Object Placemsnt |Slicer | Preview | Nanual Control|
= O = i
] a A
Scale Object (%]

ko3l i§.|sn1e to Maximun
B ]
z s | R Rasat

@ Tuisted_Vase_Besic L. B &

Show in Loz @Commands  QInfos  QWarnmings  QErrers @ACK  Qhute Seroll  @fClear Loz (RCopy

X:16.26 ¥:0.00 Z:0.000k a
Starting object analyser ...

Object is manifold. |
Inalysing finished. =

Connected: Dobot Extruder: 26 8°C/Off Idle A I

Figure 5.139 Model operation
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Step 6  Set slicing parameters and slice up.
You need to set the slicing parameters before first printing.

3. Select Slic3r from Slicer on the Slicer tab of the Repetier Host page, and click
Configuration, as shown in Figure 5.140.

e R

File View Config Printer Tools Help

O b@ b0 /y/ @ @ #n @ ®

Disconnect  Load SavePrint StartPrint  Kill Print ToggleLog Show Filament Show Travel

Printer Settings Easy Mode Emergency Stop

3D View |Tenperstwre Curva| | Object Flacemsnt | Slicer |Preview |Menual Control|

Kill Slicing

P> Slice with Slic3r ‘

|sticer:  [sticar | | [(Eehemager |
I % Confi qur ation | i

Print Setting:  [Dobet 2.0 Vase -

Printer Settings: [Dobot 2.0 Vase -

Filament settings:

Bxtruder 1 [Debot 2.0 Vase -

[7] Override Slicdr Settings

ROM@O 0 Q)

[ Copy Print Settings to Override

[ Enabls Support
[7] Enabls Cosling

Infill Denzity 0%

Show in Log: @Commands  QInfos  QMarnings
X:16.26 ¥:0.00 2:0.00ck
Starting cbject analyser ...

QFrrors  @CK  Qhuto Seroll  fjClear Log  (Copy

Cbject is manifold. B
Znalysing finished.

Connected: Dobot Bxruder: 275°C/Off Idle I I

Figure 5.140 Select slicer

The Slic3r page is displayed, as shown in Figure 5.141.
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File Window Help

Print Settings |Fi|ament Settings | Printer Seﬂings‘

|l Layers and perimeters Layer height: 04 mm
% Infill First layer height: 0.35 mm or %
) Speed
(&) Skirt and brim Vertical shells

| Support material
4l Supp Perimeters (minimum): 3 =

| Notes =

= Output options Spiral vase: [
N Multiple Extruders
#° Advanced Horizontal shells

Solid layers: Top: 3 = Bottom: 3 =

Quality (slower slicing)

Extra perimeters if needed:

Avoid crossing perimeters (slow): [7]

Detect thin walls:

Detect bridging perimeters:

Advanced

Seam position: Aligned -
External perimeters first: =

Version 1.1.7 - Remember to check for updates at http://slic3r.org/

Figure 5.141 Slic3r page

4. Set the slicing parameters on the Slic3r page.

The 3D printing effect depends on the slice parameters. This topic provides a
configuration sample, you can select File > Load Config on the Slic3r page to
import it directly for printing.

The path of the  configuration  sample is Installation
directory\DobotStudio\attachment, as shown in Figure 5.142.

File Edit View Favorites Extras Info

06 cHE-~ z| C#\Program Files\DobotStudio_Magician\attachment

Name Date modified Type Size
20/09/2017 08:58 File folder
20/09/2017 08:58 File folder

grbriade 20/09/2017 08:58 File folder

20/09/2017 08:58 File folder
B Dobot 2.0 Vase.ini 09/08/2017 19:32 Cenfiguration sett... 3KB
iz Dobot 2.0.ini 09/08/2017 19:32 Cenfiguration sett... 3KB
‘B Dobot-2.0 Vase-Cura.ini 09/08/2017 19:32 Configuration sett... 11KB
;B Dobot-2.0-Cura.ini 09/08/2017 19:32 Cenfiguration sett... 11KB
@DuhutStudiD_dH_Xﬁd.ae 09/08/2017 19:32 Application 1,896 KB
@Dnbntﬁtudinidltxﬂﬁ.exe 09/08/2017 19:32 Application 1.719KB
B Repetierl.0.6.reg 09/08/2017 19:32 Registration Entries 13KB
[Eslic2rbat 09/08/2017 19:32 Windows Batch File 1KB
Blvc010 bd.exe 09/08/201719:32  Application 5,585 KB
Fllve2010_x86.exe 09/08/201719:32  Application 4955 KB
ﬂvc?_m 3_x6d.exe 09/08/2017 19:32 Application 7,027 KB
Fhvc2013 x2bexe 09/08/201719:32  Application 6353 K8
Flvc2015x64.exe 00/08/201719:32  Application 14,944 KB
‘ﬂv:?_m 5.xB6.exe 09/08/2017 19:32 Application 14119 KB

Figure 5.142 Configuration sample

Dobot-2.0-Vase.ini is used for printing a thin-walled vase, while Dobot-2.0-ini
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is used for the filling, the filling rate is 20%.

5. Save the Printing Settings, Filament Settings and Printer Settings tabs
respectively after importing configuration sample, as shown in Figure 5.143.

= [ o T -5

File Window Help

Print Settings | Filament Settings | Printer Settings| |

Dobot 20.ini M[E] Layer height

;_afy:rs and perimeters Layer height: 2z lmm
S”k.‘rt A bri First layer height: 035 mm or %
| Skirt and brim
m'l Support material -
() Speed Save preset g
7 Multiple Extrude
‘}3 Advanced ings as: % (minimum)
= Output options Dobot 2.0 -
&l Notes ok | [ cance |
—

Solid layers:

Bottom: 3

K]

Quality (slower slicing)

Extra perimeters if needed:
Avoid crossing perimeters:
Detect thin walls:

Detect bridging perimeters:

Advanced

Seam position:

DE EEOE g 0w~

External perimeters first:

Version 1.2.8 - Remember to check for updates at http://slic3r.org/

Figure 5.143 Save configuration file

6. Click Slici with Slic3r on the Slicer tab of the Repetier Host page, as shown in
Figure 5.144.

,
EIEETUEC AT

File View Config Printer Tools Help

O.B2.=a ». S @ @ w © W

Disconnect  Load  SavePrint StartPrint  Kill Print ToggleLog Show Filament Show Travel Printer Seftings Easy Mode Emergency Stop
3D View |Temperaturs Curvs| Object Flacement | Slicer |Freview | Manusl Control |
P> Slice with Slic3r ‘ Kill Slicing
Slicer:  [Slic3r +| [ @ahemager ]
2
Print Setting [Dobot 2.0 Vase -]
Brinter Settings [Dobot 2.0 Yase -]

Filament settings

Extruder | [Dobot 2.0 ¥ase -]

(7] Override Slicdr Settings

Copy Print Settings to Override

NAR@O L 4 +(Q

Enable Support

Enable Cosling

Infill Density 0%

Show in Log' @Conmends  OInfox  QWarmings  QFrrors  @ACK  Oduto Scroll  ff Clear Log  GCopy
<S1ic3r> Unknown option infill overlap a
<51ic3r> Unknown option external perimeter_extrusion width
<51icir> Unknewn option support_material_contact_distance [
<5lic3r> Unknown option octoprint_host

Connected: Dobot Extruder: 27.1°C/Off Idle R I

Figure 5.144 Start to slice

7. Click ' on the top left corner of the Repetier Host page to print.
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File View Config

O 2. =), S/ @ @ w3 © @

Disconnect  Load  SavePrinfl StartPrint | Kill Print Togglelog Show Filament Show Travel Printer Settings Easy Mode Emergency Stop

Printer  Tools  Help

4D View |Tamparaturs Curve Object Flacement | Slicer | Preview |Manusl Control|

¥
Q
Q
2
=
!
Vi

EBreview |G-Cods Editer

Frinting Statistics

Estimated Printing Time: Th:47m:36s

Layer Count: 43891
Total Lines: 5842
Filament needed: 765 mm

¥isualization
Show Travel Moves
Show conplete Code
Show Single Layer

Show Layer Range

First Layer: o

A ||[AF

Last Layer: 1

Connected: Dobot

OlInfos  QMFarnings QFrrors  @AK  Qbhuto Seroll i Clear Log  FFCopy

=> Generating skirt/brim

=> Exporting G-code te C:\Users\Eric\AppData\Lecal\RepetierHost\composition.geode

Done. Process took 0 minutes and 1.452 seconds )
Filament reguired: 764.%mm (1.3cm3)

Extruder: 27.7°C/Off Idle _:gl

Figure 5.145 Start printing

Here we choose vase mode to print, and the product after printing as shown in Figure 5.146.
'

Figure 5.146 The product of printing
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5.9.3 Operating Cura

If you need to use Cura software for 3D printing, please launch the Cura software after burning
firmware.

Prerequisites
e Slice software Cura has been installed.

The download path is https://ultimaker.com/en/products/ultimaker-cura-software/list.

Please download the recommended version VV14.07. The way how to install and use is not
descripted in this topic.

e The 3D printing model has been prepared.

*  The printing platform has been prepared and please place it in the workspace of
Dobot Magician.

*  Dobot Magician has been powered on.

*  Dobot Magician has been connected to DobotStudio successfully (Only USB connection
is supported).

*  The 3D printing kit has been installed.
5.9.3.1 Burning Firmware

Procedure
Step1  Click 3DPrinter on the DobotStudio page.
The 3D Printing FM page is displayed, as shown in Figure 5.147.
3D Printing FM
COoOmM4

Current Firmware: De

Burning Firmwa ierHost-V4.6.0

Status: Ready to update firmware

Confirm

Figure 5.147 Burn firmware

Step 2 Click Confirm to start burning 3D printing firmware.
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After burning 3D printing firmware, if the LED indicator on the base turns red, it
indicates that the connection of the 3D printing kit is abnormal.

AWARNING

Please DO NOT operate or turn off Dobot Magician when burning firmware, to avoid
machine damage.

5.9.3.2 Performing 3D Printing
Procedure
Step 1  Launch Cura software.
Step 2 Set slicing parameters,
1. Select Machine > settings on the Cura page.
The Machine settings page is displayed.

2. Set the corresponding parameters on the Machine settings and click OK, as
shown in Figure 5.148. Table 5.16 lists the values of the parameters that need to
be set. The other parameters are set by default.

Machine settings x
Ulkirmaker2

Machine settings Printer head size

E-Steps per 1mm filament| 0 Head size towards X min (rmm) | 0

Maximum width (mm) 80 Head size towards Y min (rmm) | 0

Maximum depth (mm) 80 Head size towards ¥ max (mm}| 0

Maximum height (rnrm) 150 Head size towards Y max (mm}| 0

Extruder count 1 ~ Printer gantry haight (rmm) 0

Heated bed | . .

Machine center 0,0 —Communication seftings

Build area shape Circular ~ Serial port com7 w

GCode Flavor RepRap (Marlin/Sprinter) ~ Baudrate 115200 v
Add new machine Remove machine Change machine name

Figure 5.148 Parameters setting

Table 5.16 3D printing parameters description

Parameter Description

Maximum width The maximum width

please set to 80mm

Maximum depth The maximum with

please set to 80mm

Maximum height The maximum height

Please set to 150mm

Machine center 0,0 Machine center, please select it
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Parameter

Description

GCode Flavor

The style of GCode

Please select RepRap Marlin/Sprinter

Build area shape

Build the area shape

Please select Circular

Serial port Serial port
Please select the corresponding serial port
Baudrate Baud rate

Please set to 115200

3. Set slice parameters, and select File > Open Profile to import these parameters,

Issue V1.7.0 (2019-01-09)

as shown in Figure 5.149.

B Cura - 1407

File Tools Machine
Load model file..,
Save model...
Reload platform

Clear platform

Print...
Save GCode...

Show slice engine log...

Save Profile...

Load Profile to default

Reset Profile to default

Preferences...

Machine settings...

Recent Model Files

Recent Profile Files

QOuit

Figure 5.149

Expert Help

CTRL+L
CTRL+5

F5 Iﬂ]{@

CTRL+P

CTRL+,

Import slice parameters

The 3D printing effect depends on the slice parameters. This topic provides a

configuration sample, you can import it directly for printing.

The path of the configuration sample is Installation directory\DobotStudio
\attachment), as shown in Figure 5.150.

User Guide
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ThisPC » Windows 10(C:) » Program Files » DobotStudio » attachment

1™ Name Date modified Type Size
3dModeSt! 81215 Filefolder
CH341SER_WIN File folder
Drive File folder
grbrMode File folder
, Slic3r File folder
1] Dobot 2.0 Vaseini Configuration sett... 3B
1] Dobot 2.0.ini Configuration sett... IKE
=] Dobot-2.0 Vase-Curaiini Configuration sett... 11KB
] Dobot-20-Curaini Cenfiguration set... 11KB
BY Dobotstudio_dil_Xed.axe Application 1,696 KB
B DobotStudio_dil Xe6.exe Application 1,719 KB
) & Repetier.reg Registration Entries 11KB
& Repetierl.0.6.reg Registration Entries 13 KB
. [F] slic3rbat Windows Batch File 1B
Fl vea010x64.exe Application 5,585 KB
] vc2010 x86.exe Application B
b 1) vc2013 x6d.exe Application B
) ve2013 @6 exe Application 5,353 KB
B vea0156dexe Application 14,944 KB
P vea015.86.exe Application 14,119 KB

Figure 5.150 Configuration sample

Dobot-2.0-Vase-Cura.ini is used for printing a thin-walled vase, while Dobot-
2.0-Cura.ini is used for the filling, the filling rate is 20%.

=
4. Click , the Open 3D model page is displayed, and select the 3D printing

model prepared.

The format of 3D model is STL. You can design 3D model and transform it into
STL format.

After importing the model, click the model itself, you can center, zoom or rotate,
and so on, as shown in Figure 5.151.

W, D, H: 51.2, 51.2, 90.0 mm

Scale Y
Scale Z

Size X (mm) BN &
Size Y (mm) BN
Size Z (mm) ELCIEEE

Uniform scale o

Figure 5.151 Zoom and rotate

5. Click to connect with Dobot Magician.
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The printing window is displayed and the current printing temperature is shown
on the top corner of the window, as shown in Figure 5.152.

7 Operational.Tempemure:ZGI ==
omect [t ]
@ o
@ @
I
Temperature
0 B
Bed temp i
0 — 0 -

Figure 5.152 Printing window

6. Set Temperature to 200 and press down Enter to heat the extruder.

The temperature of the extruder should be above 170°C. Dobot Maigicain will
not start 3D printing until the filament is in the melting state. So you need to
heat the extruder first.

ADANGER

The heating rod will produce high temperature up to 250°C, please be careful. Do not let
children play with it alone. The process needs to be monitored when it is running. After
the process is completed, please turn off the equipment promptly.

Step3  Test the extruder.

Before printing, you need to test the extruder to check whether the melted filament
flows from the nozzle of the extruder.

Click the feedstock extruder or click the given stepper, such as 10, 1, 0.1 (10 is
recommended) on the Operational page and feed up to 10mm-30mm, as shown in
Figure 5.153.
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1| Operational Termperature: 199

Temperature
200 :

Bed temp
]

Figure 5.153 Click feedstock extruder

If the melted filament flows from the nozzle of the extruder, the extruder is working
properly.

ANOTICE

If the filament extrusion is in the opposite direction, please remove the filament, and turn
the extruder around, then re-push down the filament.

Step 4  Adjust the printing space and get printing coordinates.
LANOTE
During printing, if the distance from Dobot Magician to the printing platform is too large

or too small to paste the first layer, it can lead to the nozzle blockage. For increasing the
stickiness of the first layer, placing a masking paper on the platform is recommende.

1. Press the Unlock key on the Forearm and drag Dobot Magician to make the
printing head contact the surface of the masking paper(The distance between the
printing head and the surface of the masking paper is the thickness of a sheet of
A4 paper), then release the Unlock key.

2. Input command M415 on the lower right of the Operational page to get the
current coordinates, as shown in Figure 5.154.
Also, you can press the Key button on the bace of the base to get the current
coordinates.

Issue V1.7.0 (2019-01-09) User Guide Copyright © Yuejiang Technology Co., Ltd.
127




0 DoBOT Dobot Magician User Guide 5 Operation

Figure 5.154 Input command M415

Step 5  Click Print, Dobot Magician moves to the printing origin (System setting) and starts
printing.

5.10 Calibration
5.10.1 Base Calibration

The base Encoder has been calibrated before being shipped out. Generally, the J1-coordinate
is 0 <after homing, where the homing point is the system default. Namely, the Forearm is located at
the middle in front of the base.

If the J1-coordinate is not 0<(error range: 1° -3° ) after homing, you need to re-calibrate the
base Encoder.

Prerequisites

*  The writing and drawing kit has been installed. For details, please see 5.4.1 Installing
a Writing and drawing Kit.

*  Dobot Magician has been powered on.
*  Dobot Magician has been connected to DobotStudio successfully.
*  The sensor calibration board has been prepared.

Procedure

Step1 Place the Dobot Magician at the right position on the sensor calibration board, as
shown in Figure 5.155.
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Figure 5.155 Location of Dobot Magician

Step 2 (Optional) Set the homing point and make the nib contact the surface of the
calibration board.

This step is used for observing the nib position on the calibration board when moving
J1-axis in Step 5, to improve calibration accuracy.

1. Click Teaching&Playback on the DobotStudio page.
The Teaching&Playback page is displayed.

2. Press the Unlock key on the Forearm and drag Dobot Magician to make the nib
contact the surface of the calibration board, then release the Unlock key.

The coordinates of this point will be displayed on the Teaching&Playback
page.
3. Select this point and right-click SetHome, as shown in Figure 5.156.

Figure 5.156 Set homing position
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Step3  Click Setting > Base Calibration on the DobotStudio page.
The Base Calibration page is displayed.

Step 4  Click Next on the Base Calibration page.
Dobot will start homing. Please ensure that there are no obstacles in the workspace
during homing.

Step5  Click +J1 or -J1 to make the nib at a point on the line between A3 and B3 on the
calibration board, as shown in Figure 5.157 and Figure 5.158.

If the speed is too fast when moving J1-axis, you can drag Speed slider to adjust
speed.

) Base Calibration
General
Update
Firmware
tton. Please ensure
Sensor and Base
Base Calibration

Manual Levelling

Auto Levelling FineTune
Speed

Initial Pos

Jog
Playback
Write Draw
Leap Motion
Mouse

serEnaravi C.
LaserEngraving Cancel

Figure 5.157 Move J1-axis

Issue V1.7.0 (2019-01-09) User Guide Copyright © Yuejiang Technology Co., Ltd.
130




0 DOBOT Dobot Magician User Guide 5 Operation

=
L J

Figure 5.158 Nib position

Step 6 Click Calibration to start calibrating the base Encoder.

You can check the J1-coordinate on the Operation Panel page, as shown in Figure
5.159.
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Operation Panel

ﬁ

Figure 5.159 Ji1-coordinate

5.10.2 Sensor Calibration

The angle sensors of the Forearm and Rear Arm have been calibrated before being shipped out.
Generally, the Z-coordinate will remain the same when moving Dobot Magician in the same
horizontal plane. If changed, you need to recalibrate the angle sensors by manual levelling or auto
levelling to improve the positioning accuracy.

* Manual Levelling: It is more accurate to calibrate manually with DobotStudio,
sensor calibration board, and writing and drawing kit, which is suitable for the application
scenarios with high requirements for absolute positioning accuracy.

*  Auto Levelling: It is simple and quick to calibrate automatically with DobotStudio

and auto-levelling tool, which is suitable for the application scenarios without high

requirements for absolute positioning accuracy, such as writing and drawing, 3D printing.
5.10.2.1 Manual Levelling

Prerequisites
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*  Dobot Magician has been powered on.
*  Dobot Magician has been connected to DobotStudio successfully.
*  The sensor calibration board has been prepared.

Procedure

Step1  Place the Dobot Magician at the right position on the sensor calibration board, as

shown in Figure 5.160.

Figure 5.160 Location of Dobot Magician

Step 2 Click Setting > Manual Levelling on the DobotStudio page.
The Manual Levelling page is displayed.
Step3  Click Next on the Manual Levelling page.

Dobot Magician will finish the auto-compensation of the angle senor coefficients of
the Forearm and Rear Arm move according to the system settings. The result is as
shown in Figure 5.161,

ANOTICE

Please remove all end-effectors from Dobot Magician before calibrating
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@ Manual Levelling

General
Update

Firmware

SRR Change RearArmAngleCoef From[gielels¥s 611.0078

Base Calibration

Change FrontArmAngleCoef From|[UREiElsE] [410.9918
Manual Levelling

FineTune

Auto Levelling Speed

Initial Pos

Jog
Playback
Write Draw
Leap Motion
Mouse

LaserEngraving

Next Cancel

Figure 5.161 Get the angle sensor coefficients

Step 4  Click Next and set Angle Precision, Distance Precision, Result Range.

In this step, please keep the default values, as shown in Figure 5.162.

© Manual Levelling

General
Update

Firmware

Angle Precision
Sensor and Base

g 3 Distance Precision
Base Calibration

" Result Range
Manual Levelling

FineTune

Auto Levelling Speed

Initial Pos
Jog
Playback
Write Draw
Leap Motion
Mouse

LaserEngraving

Next Cancel

Figure 5.162 Set precisions

Step 5  Click Next and follow the instructions on the Manual Levelling page to move Dobot
Magician to the first calibrated point. If the calibrated point is A3 on the Calibration
board.
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1. Install the writing and drawing Kkit. For details, please see 5.4.1 Installing a
Writing and drawing kit.

2. Press the Unlock key on the Forearm and drag Dobot Magician to make the nib
near the A3 point on the calibration board, then release the Unlock key.

3. Click coordinate buttons on the Manual Levelling page (as shown in Figure
5.163) to make the nib align to the center of A3 point on the calibration board, as
shown in Figure 5.164.

If the speed is too fast when clicking coordinate buttons, you can drag Speed
slider to adjust speed.

© Manual Levelling

General
Update

Firmware

Step1. Install the Pen Effector On Dobot.

Sensor and Base
Step2. Hand hold Dobot to the place near 1st calibration position.
Base Calibration
: Step3. Use motion button to fine tune the position.

Manual Levelling

FineTune
Auto Levelling Speed

Initial Pos X

J
og X
Playback
Write Draw
Leap Motion

Mouse

LaserEngraving Next Cancel

Figure 5.163 Fine-tune page
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Figure 5.164 Nib position

Step 6 Click Next and follow the instructions on the Manual Levelling page (as shown in
Figure 5.165) to move Dobot Magician to make the nib in the center of the second
calibrated point. If the calibrated point is B3 on the calibration board, as shown in
Figure 5.166.

ANOTICE

Please DO NOT drag Dobot Magician in this step, to avoid manual levelling failure. If
the speed is too fast when clicking coordinate buttons, you can drag Speed slider to adjust
speed.
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@ Manual Levelling

General
Update

Firmware

S amear A s Step1. Don't touch Dobot with your hand.

Base Calibration

Step2. Use motion button to move Dobot to 2nd calibration position and fine tune it.

Manual Levelling
FineTune
Auto Levelling Speed

Initial Pos X

Tt
Jog ~
Playback
Write Draw
Leap Motion

Mouse

LaserEngraving Cancel

Figure 5.165 Fine-tune page

Figure 5.166 Nib position on the second calibrated point

Step 7  Click Next and set the distance between the two calibrated points, as shown in Figure
5.167.

The distance between the two calibrated points on the Calibration board is 80mm, so
please keep the default value in this step.
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Step 8

Please input the distance of the two position.

FineTune
Speed

80.00 mm

Cancel

Figure 5.167 Set the distance between the two calibrated points

Click Next to start calibrating.

The result is shown as Figure 5.168.

© Manual Levelling

General
Update

Firmware

Sensor and Base

Sensor Calibration Succeeded.

B——— Change RearArmAngleError From{URelerEyy 6-0.1473
ase Calibration

m — Change FrontArmAngleError From|[SREER [0 -0.5473
Manual Levelling

Auto Levelling

Initial Pos

Jog
Playback
Write Draw
Leap Motion

Mouse

LaserEngraving

FineTune
Speed

Cancel

Figure 5.168 Calibrating result

5.10.2.2 Auto Levelling

Prerequisites
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*  Dobot Magician has been connected to a PC via USB cable.
*  Dobot Magician has been connected to the power adapter.

*  The auto-levelling tool has been obtained, as shown in Figure 5.1609.

Figure 5.169 Auto-levelling tool

Procedure

Step1  Place Dobot Magician on the flat platform.

ANOTICE

Please ensure that the platform is flat. Or, the auto levelling will be failed.

Step 2 Fix the auto-levelling tool on the Dobot Magician with clamp fixing screw, as shown
in Figure 5.170,
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Figure 5.170 Fix auto-levelling tool

Step 3  Insert the cable of the auto-levelling tool to the interface 2 on the Forearm, as shown
m Figure 5.171,

Figure 5.171 Insert the cable of the auto-levelling
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Step4 Power on Dobot Magician and connect it to DobotStudio.
Step S Click Setting > Auto Levelling on the DobotStudio page.
The Auto Levelling page is displayed, as shown in Figure 5.172.

ANOTICE

Please ensure that there are no obstacles in the workspace during auto levelling.

O Auto levelling

General
Update

Firmware

Step 1.Install auto leveling end effector. Step 2.Ensure no obstacles around Dobot.

Sensor and Base
Base Calibration

Manual Levelling
Auto Levelling

Initial Pos

Jog
Playback
Write Draw
Leap Motion

Mouse

LaserEngraving

Start

Figure 5.172 Auto levelling page

Step 6  Click Start on the Auto Levelling page.

Dobot Magician starts auto levelling. The levelling process will takes about 2
minutes. The result is shown as Figure 5.173.

LAONOTE

If the auto levelling is failed, please check if the platform is flat and try again.
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o Auto levelling

General
Update

Firmware

Sucessed to calibration. The result is 0.24
Sensor and Base

Base Calibration

Manual Levelling

Auto Levelling

Initial Pos

Jog
Playback
Write Draw
Leap Motion
Mouse

LaserEngraving

Quit

Figure 5.173 Auto levelling result

5.10.3 Homing

Dobot Magician has been calibrated before being shipped out. If the Dobot Magician has been

hit or the motor has lost step, leading data abnormal, you need to operate homing to improve the
positioning accuracy.

Prerequisites
*  Dobot Magician has been powered on.

*  Dobot Magician has been connected to DobotStudio successfully.
Procedure

Click Home on the DobotStudio page, as shown in Figure 5.174.

ANOTICE

*  Please remove the end-effector from the Dobot Magician before homing.

*  Please ensure that there are no obstacles in the workspace during homing.

Figure 5.174 Operate homing

Dobot Magician will rotate clockwise to the limited position and then return to the default
homing point automatically and the LED indicator on the base turns blue and is blinking. After the
homing is successful, there is a beep sound and the LED indicator turns green.
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Also, the homing point can be use-defined, you can select a saved point on the

Teachong&Playback page and right-click SetHome to set this saved point as the homing point, as
shown in Figure 5.175.

+Point
224229 82913

26.8754 21176

@rTP Point
167.5437 1749825 50.2059 462441

-61.3746 2345348 -1.4904 1046647

-102.7602 2474383 -24.741 1125529

-113.2772 217.331 -10.0584 117.5294

-125.0657 218.7935 -15.6746

119.7529

MoveDown
DeleteAll
RunSeleted
[
SetHome

Figure 5.175 Set homing point

5.11 Connecting with WIFI Kit

You can connect Dobot Magician to a PC via WIFI kit without USB cable, making Dobot
Magician and PC in the same WLAN. Figure 5.176 shows the WIFI Kit.

Figure 5.176 WIFI kit

Prerequisites

Dobot Magician has been connected to a PC via USB cable.

Dobot Magician has been connected to the power adapter.
Issue V1.7.0 (2019-01-09) User Guide
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PC.

Procedure

Step 1

The WIFI name and password have been obtained and must be the same as that of

Connect the WIFI kit to the UART interface on the base, as shown in Figure 5.177.

° ® ‘
= —
Idux {nad /o8

Figure 5.177 Connect with WIFI kit

ANOTICE

Please turn off the Dobot Magician completely first before connecting or disconnecting
external equipment. Or, it causes serious damage to your device

Step2  Press down the power button to turn on the Dobot Magician.
After turning on, there are two short beep sounds and the blue LED indicator on the
WIFI module is on.

Step3  Select the corresponding serial port from the serial drop-down list, and click
Connect.

Step4  Click Setting > Wi-Fi.
The Set Dobot Wi-Fi page is displayed.

Step 5 Set the related parameters on the Set Dobot Wi-Fi page.
In this topic, please select Dynamic Host Configuration Protocol (DHCP) and set
SSID and Password to obtain the IP address of Dobot Magician, as shown in Figure
5.178.
If you unselect Dynamic Host Configuration Protocol (DHCP), you need to set IP
address, Netmask, Gateway. For details, please see Table 5.17.
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©  Set Dobot Wi-Fi

General
Update
Firmware

IPAddress

Wi-Fi
' Netmask

Sensor and Base
Base Calibration

Manual Levelling

Auto Levelling

Initial Pos

Jog
HEET
Write Draw
Leap Motion
Mouse

LaserEngraving

Figure 5.178 Set WIFI

Table 5.17 Parameter description

Parameter Description

SSID Set WIFI name

that of PC

The WIFI name and password have been obtained and must be the same as

Password Set WIFI password

Dynamic Host Configuration | Whether to select DHCP

Protocol (DHCP) Yes: Only set SSID and Password

No: Only set IPAddress, Netmask and Gateway

IPAddress Set the IP address of Dobot Magician. The IP address of Dobot Magician and
the PC must be in the same WLAN without conflict.

Netmask Set subnet mask
Gateway Set gateway
DNS Set DNS

Step 6 Click OK.
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About 5 seconds later, the green LED indicator on the WIFI module is on, indicating
that the Dobot Magician has been connected with WLAN, as shown in Figure 5.179.

® [ ]

Foa T [dre ¥ PAl

L—l el
T

Figure 5.179 Status of LED indicator

Step 7 Click Disconnect on the left pane of the DobotStudio page.

Step 8  After 2 seconds later, select the IP address from the drop-down list on the upper left
pane of the DobotStudio page and click Connect, as shown in Figure 5.180,

<

g COM4

Figure 5.180 IP address of Dobot Magician

After the connection is successful, you can control Dobot Magician without USB
cable.

5.12 Connecting with Bluetooth Kit

Dobot Magician can be connected to smart phone with Bluetooth. Figure 5.181 shows the
Bluetooth Kkit. Please download the matched DobotStudio APP from the website
https://cn.dobot.cc/downloadcenter.html?sub cat=69#sub-download.
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Figure 5.181 Bluetooth kit

Prerequisites
*  Dobot Magician has been connected to the power adapter.
*  The DobotStudio APP has been downloaded.

Procedure

Step 1  Connect the Bluetooth kit to the UART interface on the base, as shown in Figure
5.182.
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\

Figure 5.182 Connect with Bluetooth kit

ANOTICE

Step 2

Please turn off the Dobot Magician completely first before connecting or disconnecting
external equipment. Or, it causes serious damage to your device.

Press down the power button to turn on the Dobot Magician.

After turning on, there are three short beep sounds and the blue LED indicator on the
Bluetooth module is on and the green one is blinking.

Turn on the Bluetooth and launch DobotStudio APP on your phone. And click
Connect to connect with Dobot Magician.

This topic only describes how to connect Bluetooth kit. For details how to operate
Dobot Magician with DobotStudio APP, please see
https://www.youtube.com/watch?v=kyeXwuf171Y.

5.13 Operating Blockly

Blockly is a programming platform based on Google Blockly. You can program through the
puzzle format, which is straightforward and easy to understand.

Prerequisites
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*  Dobot Magician has been powered on.
*  Dobot Magician has been connected to DobotStudio successfully.
Procedure
Step1  Click Blockly on the DobotStudio page.
The Blockly page is displayed.

Step 2 Drag the blockly module on the left pane of the Blockly page to program, as shown
in Figure 5.183.

Loops
Math
Text
Lists

. wowto x o3 v ol 2 ¥EEN

Colour

Variables [ T~T | polatis o=
Functions MoveTa X ¥ z
v ooboraP WEEID Detaytime o]
Basic -
Config
Motion 2
1o L |

Additional

Figure 5.183 Blockly graphic programming

Table 5.18 lists the description of blockly module.

Table 5.18 Blockly description

No. Description

1 The selection area of blockly module, including
logistic, loop, math, and Dobot API. You can program

by dragging them to the window.

2 The window of blockly programming
3 The running log of Dobot Magician
4 The corresponding codes of the blockly module on the

programming window

The demo in Figure 5.183 is described as follows.
1. Set the end-effector as Gripper.
2. Set the loop number as 3 and make the Z-axis move back and forth 3 times.
3. Set the pause time as 3.
Step3  Click Save on the Blockly page.
The Saving Blockly file page is displayed.
Step 4  Input the use-defined name and the saving path, and click Save. The default path of
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Step 5

the programing file is Installation directory/DobotStudio/config/bystore. Please
replace the path based on site requirements.
Click Start on the Blockly page, and Dobot Magician will move according to the

program.

5.14 Scripting

You can control Dobot Magician over scripting. Dobot Magician supports various API, such
as velocity/acceleration setting, motion mode setting, and 1/O configuration, which uses Python
language for secondary development. For details about the Dotob Magician API interface and
function description, please see Dobot Magician APl Description.

The download path is https://www.dobot.cc/downloadcenter.html?sub_cat=72#sub-download.

Prerequisites

Procedure
Step 1

Step 2

Dobot Magician has been powered on.

Dobot Magician has been connected to DobotStudio successfully.

Click Script on the DobotStudio page.
The Script page is displayed.
Write a script.

You can call the interface by double-clicking on the left pane of the Script page, the
corresponding interface will be displayed on the middle pane, as shown in Figure

5.184. You can also click icon of the corresponding interface to view the way

how to set the parameters. The scripting examples (including Jog, PTP, and Pallet)
can refer to Installation directory/DobotStudio/config/ststore/.

pallet (row:11,col:8)

200,200,200, 200, 200, 200)

9,200,200, 200)

)

0, 100)
1

api, dType.PTPMode.PTEMOVLEYZMode, xtmoveX, y+moveY, ztmoveZ, rhiead, 1)
weFlag

dType.PTPMode . FTPMOVLEYZMode, X+moveX, y+moveY, z+moveZ, rHead, 1)
zead, 1)

d (apt,
d (api,

- PTPMode . PIEMOVLEYZMode, xtmoveX, yimovel, z,

dIype

Figure 5.184 Write a script
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Step3  Click Save on the Script page.
The Saving Scrip File page is displayed.
Step 4 Input the use-defined name and the saving path, and click Save.

The default path of the script is Installation directory/DobotStudio/config/ststore.
Please replace the path based on site requirements.

Step 5  Click Start, and Dobot Magician will move according to the script file.

The running log will be displayed on the lower pane of the Script page for checking.

5.15 Operating Stick Controller Kit

Dobot Magician can be controlled by stick controller kit without DobotStudio. Figure 5.185
shows the stick controller kit. From left to right: Stick controller, USB Host module, USB cable
(used for charging stick controller), Transceiver.

Figure 5.185 Stick controller kit

Prerequisites
*  Dobot Magician has been connected to a PC over USB cable.
*  Dobot Magician has been connected to the power adapter.
Procedure
Step1 Connect the transceiver to the USB module.

Step2  Connect the USB Host module to the UART interface on the base, as shown in Figure
5.186.
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Figure 5.186 Connect with USB Host module

Step3  Press down the power button to turn on the Dobot Magician.

The blue LED indicator on the USB Host module is on. After turning on, there are
four short beep sounds and the green one is on.

ANOTICE

Please turn off the Dobot Magician completely first before connecting or disconnecting
external equipment. Or, it causes serious damage to your device.

Step 4  Press down the power button on the stick controller, as shown in Figure 5.187.

The red LED indicator on the middle of the stick controller is blinking, indicating
that the Dobot Magician can be controlled by the stick controller.
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Figure 5.187 Power button of the stick controller

Table 5.19 lists the functions of buttons on the stick controller.

Table 5.19 Button function

Button

Function

Power button

Turn on stick controller

The stick controller will turn off automatically

LT Turn on the peripheral motor

RT Turn off the peripheral motor off

RB Switch to Cartesian coordinate system mode
LB Switch to Joint coordinate system mode

X Control the outtake of the air pump

Y Control the intake of the air pump

B Turn off the air pump

Left stick: Front/back

. Cartesian coordinate system mode: Dobot
Magician moves along X-axis in the
positive/negative direction

. Joint coordinate system mode: Dobot Magician

rotates  along  Jl-axis in the
positive/negative direction

Left stick: Left/right

. Cartesian coordinate system mode: Dobot

Magician moves along Y-axis in the
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Button

Function

positive/negative direction

Joint coordinate system mode: Dobot Magician
rotates  along J2-axis in the
positive/negative direction

Right stick: Front/back

Cartesian coordinate system mode: Dobot
Magician moves along Z-axis in the
positive/negative direction

Joint coordinate system mode: Dobot Magician

rotates  along J3-axis in the
positive/negative direction

Right stick: Left/right

Cartesian coordinate system mode: Dobot
Magician rotates along R-axis in the
positive/negative direction

Joint coordinate system mode: Dobot Magician

rotates  along J4-axis in the
positive/negative direction

5.16 Operating Sliding Rail

When the workspace of Dobot Magician is not enough, you can extend it with the sliding kit
to do large-scale tasks, such as long-distance picking and placing, a large range of writing and so
on. Figure 5.188 shows the sliding rail kit and Table 5.20 lists its description.
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Figure 5.188 Sliding rail kit

Table 5.20 Sliding rail kit description

No. Description

1 Tool kit

2 Screws

3 Plate a

4 Plate ¢

5 Sliding rail (with wire set and plate b)

5.16.1 Installing sliding rail

Procedure

Step1  Mount Dobot Magician on the plate a with four M3*10 countersunk head cap screws
(The counter bore of plate a is outwards), as shown in Figure 5.189.
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Figure 5.189 Fix plate a

Step 2 Fix the plate a (with Dobot Magician) on the plate b with three M3*8 hexagon socket
head cap screws. Please make the back of the base of Dobot Magician towards the
rabbet on the plate b, as shown in Figure 5.190.
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Figure 5.190 Fixed position with screws

Step3  Connect the end of the wire set to the plate b with a M3*6 countersunk head hexagon
screw, as shown in Figure 5.191,

Figure 5.191 Connect with wire set

Step 4  (Optional) Fix plate ¢. This step is only needed when using air pump for picking and
placing or other tasks.
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1. Fix the plate c on the plate a with two M3*8 hexagon socket head cap screws, as

shown in Figure 5.192.

y
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Figure 5.192 Fix plate c

2. Fix the air pump on the plate c, as shown in Figure 5.193. And connect the air

pump to Dobot Magician. For details, please see 5.2.1 Installing a Suction Cup
Kit.

Figure 5.193 Fix air pump

Step 5  Connect the interfaces on the end of the wire set to Dobot Magician, as shown in

Figure 5.194.
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Figure 5.194 Connect V2 Sliding rail to V2 Dobot Magician

Step 6 Connect the interfaces on the other end of the wire set to the power adaptor, USB
interface of PC, motor interface and homing interface of the sliding rail respectively.
Figure 5.195 shows the interfaces on the other end of the wire set.

Motor interface

00099

——Homing inteface

—— USB interface

——Power interface

Figure 5.195 Interfaces on the other end of the wire set

Figure 5.196 shows the connection between the sliding rail and the wire set.
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Figure 5.196 Connect sliding rail and wire set

5.16.2 Sliding Rail Parameter Description

Table 5.21  Sliding rail parameter description

Parameter Description
Maximum payload 5kg
Maximum Distance 1000mm
Maximum speed 150mm/s
Maximum acceleration 150mm/s?
Repeated positioning accuracy 0.01mm
Absolute positioning accuracy 0.25mm

5.16.3 Demo Description

This topic describes how to use the V2 version of sliding rail for writing.
Prerequisites
e The sliding rail has been installed and connected to the Dobot Magician.
*  Dobot Magician has been powered on.
*  Dobot Magician has been connected to DobotStudio successfully.

*  The writing and drawing kit has been installed. For details, please see 5.4.1 Installing
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a Writing and drawing Kit.
Procedure

Step1 Select New Linear Rail on the Setting > General page of DobotStudio and Click
OK, as shown in Figure 5.197,

[
sole When Startup o

Use Linear Rail V2

Default Ok Cancel

Figure 5.197 Select New Linear Ralil

Step2  Click LineraRail on the DobotStudio page.
Now, you can click L+, L- to make Dobot Magician move to the left or right.
Step3  Click Home on the DobotStudio page.

The sliding block moves to its homing point and then Dobot Magician rotates back
to its homing point.

Step 4 (Optional) Save points on the Teaching&Playback page, so as to trigger them for
some operations when Dobot Magician moves on the sliding rail, such as inking

brush during writing.

For details about teaching and playback, please see 5.2 Performing Teaching &
Playback Tasks.

1. Click Teaching&Playback on the DobotStudio page.
The Teaching&Playback page is displayed.
2. Save points on the Teaching&Playback page.
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The saved points list is as shown in Figure 5.198.

|

o
£

)

& =

Figure 5.198 Save points

L indicates the position where Dobot Magician is located on the sliding rail, and
the speed and acceleration can be set on the Setting > Playback page.

3. Click Exit to close Teaching&Playback page.
Step5 Click Write&Draw on the DobotStudio page.
The Write&Draw page is displayed, as shown in Figure 5.199.

For details about writing and drawing, please see 5.4 Writing and Drawing.

Input Shapes

Figure 5.199 Write&Draw page

The rectangle in Figure 5.199 is the workspace of Dobot Magician (with sliding rail).
Step 6  Input text on the Iput Texts pane and click OK, as shown in Figure 5.200.
If the text is Magician.
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Magiciar

Figure 5.200 Input text

Step 7 (Optional) Right-click Add a playback trigger on the Write&Draw page to sct
trigger points, as shown in Figure 5.201.

Input Shapes

Figure 5.201 Set trigger point

If the trigger points are set after the first letter a and the letter ¢, as shown in Figure
5.202.
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Figure 5.202 Trigger lines

Step 8 Click Start.

Dobot Magician starts writing. Take the first trigger point as an example, after writing
the first letter a, the saved points list on the Teaching&Playback page is triggered,
and Dobot Magician moves to the set position to perform the related operations
according to the saved points list. Then, Dobot Magician continues to write.

5.17 Multiplexed I/0O Demo

The addresses of the I/O interfaces in Dobot Magician are unified. Most of 1/0 interfaces have
multiple functions. For details, please see 4.3 Multiplexed I/O Interface Description.

You can set I/O interfaces on the advanced Teaching&Playback page to control the peripheral
equipment, as shown in Figure 5.203.

Figure 5.203 1/O setting page

Now, demos of level output, level input, and PWM output are given below.
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Level Output

Normally, air pump can be controlled by the 1/0O interfaces. The 1/0 11 controls its intake (High
level) and outtake (Low level) and the I/O 16 controls its start-stop. Table 5.22 lists the multiplexed
descriptions of 1/0 11 and 1/O 16.

Table 5.22 Multiplexed 1/0O description

1/0 addressing | Voltage Level Output PWM Level Input ADC
11 3.3V V v - -
16 12v V - - -

The I/0 11 and I/0O 16 are located at the peripheral interface of the base, as shown in Figure
5.204.

EIO10 EIO11 EIO12 ElIO16
b A 4 A
GND REV PWM ADC 5 1A 5 1B 5_2A 5 2B GND VALVE
b A A 4 b A 4 4 A 4
e oo ceo e o o o
e e e H‘ e o 00 |® @
> v Vv X ¥y vYVY 4 v ¥
GND REV PWM ADC 51A 5 1B52A 5 2B GND PUMP
[ 2 | 4 v v
EIO13 EIO14 EIO15 EIO17

Figure 5.204 Peripheral Interface on the base

Prerequisites

*  The air pump has been connected to Dobot Magician. For details, please see 5.2.1
Installing a Suction Cup Kit.

*  Dobot Magician has been powered on.
*  Dobot Magician has been connected to DobotStudio successfully.
Procedure

Select Pen from the end-effector drop-down list on the DobotStudio page, as shown
m Figure 5.205,

Step 1

User Guide
165

Issue V1.7.0 (2019-01-09) Copyright © Yuejiang Technology Co., Ltd.




0 DoBOT Dobot Magician User Guide 5 Operation

SuctionCup

Teachin .
Iy Gripper

Laser

7 Advanced

Figure 5.205 Select end-effector

ANOTICE

Normally, If SuctionCup or Gripper is selected from the end-effector drop-down list
after the air pump has been connected, the air pump will be controlled by the system. In
this topic, we use 1/0 interfaces to control the air pump, so SuctionCup and Gripper
cannot be selected, to avoid conflict.

Step2 Click icon on the Teaching&Playback page, as shown in Figure 5.206.

Figure 5.206 Switch advanced function

Step3  Select IO_11, I0_16 and their corresponding Value on the Qutput pane, and click
+Point.

“The saved point is displayed on the Teaching&Playback page, as shown in Figure
5.207.

LONOTE

If the intake is not obvious, please modify PauseTime of this saved point.
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Figure 5.207 Saved point

Step 4  Select this point and click StepRun.
The air pump is humming with intake.

StepS  Select I0_11,10_16 and the corresponding Value of 10_16 on the Output pane, and
click +Point.

The saved point is displayed on the Teaching&Playback page, as shown in Figure
5.208.

Figure 5.208 Saved point

Step 6  Select this point and click StepRun.

The air pump is humming with outtake.
5.17.2 Level Input

This topic also takes 1/0 12 as an example.
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Table 5.23 Multiplexed I/O description

1/0 addressing | Voltage Level Output PWM Level Input ADC

12 3.3V - - v -

Prerequisites
*  Dobot Magician has been powered on.
*  Dobot Magician has been connected to DobotStudio successfully.
*  The saved points list has been existed on the Teaching&Playback page.

Procedure

Step1 Click icon on the Teaching&Playback page, as shown in Figure 5.209.

Figure 5.209 Switch advanced function

Step2  Select a saved point on the Teaching&Playback page.
Step3  Select EIO11_Input on the Trigger pane, and set Condition and its Value,

Here, Value only can be set to 0 or 1. 1: High level; 0: Low level.

Step 4 Click ADD, as shown in Figure 5.210.

© DobotStudio-untitied.playback

/ar

BRFFEE

Figure 5.210 Saved point
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517.3 PWM OUTPUT

This topic also takes I/0O 11 as an example.

Table 5.24 Multiplexed 1/0O description

1/0 addressing | Voltage Level Output PWM Level Input ADC

11 3.3V N \ - -

Prerequisites
*  Dobot Magician has been powered on.
*  Dobot Magician has been connected to DobotStudio successfully.

Procedure

Step1 Click icon on the Teaching&Playback page, as shown in Figure 5.211.

Figure 5.211 Switch advanced function

Step2  Select I0_11 on the Output pane, and click +Point, as shown in Figure 5.212.

Figure 5.212 Saved point

Step3  Double-click EIO11 cell and select ... from the drop-down list.
The EIO Setting page is displayed, as shown in Figure 5.213.
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Figure 5.213 EIO setting

Step4  Sct Frequency (Unit: KHZ; Value range: 10HZ-1MHZ) and DutyRatio (0%-100%)
on the EIO Setting page.
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Appendix A Dobot Magician Homing Operation

Homing Procedure:

1. Turn on Dobot Maigcian, wait for about 20 seconds after green light is on, and then click
Home on Dobot Studio page to make Dobot Magician execute homing operation.

2. Blue light will flash during homing, and Dobot Magician will execute homing operation.
Do not operate the Dobot until the green light is on.

3. Save points and download them to Dobot Magician. Click OK to wait downloading
finished.

@ Question

Do you want to add homing
command before running in offline
mode?

OK Cancel

Figure 5.214 homing tip

4. Disconnect USB cable and press down Key button to execute offline mode.
Playback Procedure:

If there are some points saved in Dobot Magician before, you can turn on Dobot Maigican
directly, wait for about 20 seconds after green light is on, press down Key button for long time
to execute homing operation, and then press down Key button again to execute offline mode.
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